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How to Use this User Guide

This handbook accompanies the taught sessions for the course. Each section contains
a brief overview of a topic for your reference and then one or more exercises.

Exercises are arranged as follows:
. A title and brief overview of the tasks to be carried out;
. A numbered set of tasks, together with a brief description of each;
. A numbered set of detailed steps that will achieve each task.

Some exercises, particularly those within the same section, assume that you have
completed earlier exercises. Your teacher will direct you to the location of files that
are needed for the exercises. If you have any problems with the text or the exercises,
please ask the teacher or one of the demonstrators for help.

A number of conventions are used to help you to be clear about what you need to do
in each step of a task.

In general, the word press indicates you need to press a key on the keyboard. Click,
choose or select refer to using the mouse and clicking on items on the screen.

Names of keys on the keyboard, for example the Enter (or Return) key are shown like
this ENTER.

Multiple key names linked by a + (for example, CTRL+Z) indicate that the first key
should be held down while the remaining keys are pressed; all keys can then be
released together.

Words and commands typed in by the user are shown 1ike this.
Labels and titles on the screen are shown like this.

Drop-down menu options are indicated by the name of the options separated by a
vertical bar, for example Home tab |Copy. In this example you need to select the
option Copy from the Home tab from the Ribbon. To do this, choose the Home tab
from the Ribbon; move the cursor to Copy button; when Copy is highlighted, click
the mouse button again.

A button to be clicked will look

The names of software packages are identified like this, and the names of files to be
used like this.
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1 Introduction

Welcome to the course Spreadsheets: Organising and Displaying Data.

This booklet accompanies the course delivered by Oxford University IT Services, IT
Learning Programme. Although the exercises are clearly explained so that you can
work through them yourselves, you will find that it will help if you also attend the
taught session where you can get advice from the teachers, demonstrators and even
each other!

If at any time you are not clear about any aspect of the course, please make sure you
ask your teacher or demonstrator for some help. If you are away from the class, you
can get help by email from your teacher or from help@it.ox.ac.uk.

1.1. What you should already know

We expect you to have a level of experience in Excel that would be gained from
attending the Office: Fundamentals course.

You should be able to open and navigate around a workbook using the mouse and
scrollbars, use the help function, add data to cells, and select and amend such data.
You should also be able to save a worksheet.

The computer network in IT Services may differ slightly from that which you are used
to in your College or Department; if you are confused by the differences, ask for help
from the teacher or demonstrators.

By the way, did we say that you can ask for help from the teachers or demonstrators ©!

1.2. What you will learn
At the end of this session you will have learned how to work using

You will learn some advanced charting techniques including plotting non-adjacent
areas and inserting new data into an existing chart. You will also learn how to create a
mixed type chart using a secondary axis.

You will learn how to create histograms that show the distribution of data: histograms
are commonly used to summarise data

Topics covered are:
e Working with ranges and tables of data
e Filtering your data
e Subtotal and group your data
e Charting non-adjacent worksheet areas and charting filtered data
e Working with mixed chart types
e Formatting charts
e Charting on a secondary axis
¢ Adding data series

e Creating histograms and sparklines

These notes deal with Excel 2013. Having worked through these notes, you should
also be able to adapt to earlier versions (for example, Excel 2010), and also to later
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releases, since most of the basic principles hold true regardless of the version of the
software.

1.3. What is Excel?

Excel 2013 is part of the Microsoft Office 2013 package. Spreadsheets allow you to
present and analyse data in a wide variety of ways and Microsoft Excel is perhaps the
world’s most popular spreadsheet application.

1.4. Where can I get a copy?

If you have a copy of Microsoft Office 2013, then you already have a copy of Excel
2013. If you are unable to find it on your computer, it may not have been installed and
you should talk to your IT support contact (or the IT Services Help desk).

If you are a member of staff, you can obtain a copy of Microsoft Office 2013 from the
IT Services shop. Students can obtain a Microsoft Student Licence, but this must be
bought through a Microsoft Authorised Education Reseller; the IT Services shop can
direct you to a suitable reseller.

IT Learning Programme 2
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2 Ranges and Tables in Excel

2.1. Working with a range

2.1.1.

What is a range?

It is likely that until now you have been working with a range or ranges of data in
Excel. A range consists of a group of cells which are grouped together, they are
usually rectangular in shape. For example cells A1, A2, A3, B1, B2, B3 the range of
these cells would be A1:B3, see Figure 1

1
2
3
4

Figure 1: Range of cells

Ranges and named ranges only expand or contract when rows are inserted or deleted
from the middle of the data and not when added to the end. Data remains static.

Any formulas or charts linked to a range or named range would need to be adjusted to
accommodate future changes.

2.2. Working with a table

2.2.1.

2.2.2,

Introducing tables

This section introduces you to a special form of tabular data, similar to a database,
which in Excel is called a table. In earlier versions of Excel they were known as lists;
tables are the evolution of that feature with a few added benefits.

We will cover basic procedures to manipulate, manage, sort, summarise and
otherwise analyse data held in the table.

What is a table?

Tables were introduced in Excel 2007 and 2010. They are a new way of working with
tabular data. They are particularly useful when working with data which expands and
contracts over time, also known as ‘dynamic data’. The differences are that tables
have additional functionality and are more helpful in appearance than ranges.

By converting your range of data to a table you will ensure that when further data is
added it will still include it as part of the data set. In contrast to where ranges and
named ranges only expand or contract when rows are inserted or deleted from the
middle of the data and not when added to the end, hence why tables are considered a
preferred option when working with an expanding data set.

A table comprises a series of columns and rows containing related data, such as a set
of client names and addresses. A table can be used as a database, in which rows are
records and columns are fields. By default, tables display rows in alternating colours
to distinguish data. The first row (header row) of the table usually contains the
column labels and is differentiated in some way. For example, the headings might be
emboldened or set in a different font and filter arrows appear, see Figure 2 below
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A B C D
1 - - - M
2 Smith Andrew 1 0X1 2NJ
3 |Jones John 3 0¥4 2YR

A

Figure 2: Table view 1

Excel makes reference to headings to summarise data in tables and when rows of data
are longer than the page you can see the headings move to replace the column letters,
see Figure 3

Sumame | - |First Name |~ | House Number |~ |Post Code |~

4 Smith Andrew b OX1 2MJ

5 Jones John T 0¥4 2%YR

£ Belcher Sam g OX1 2MJ

7 Mitchell Paul 11 OX4 2¥R
Figure 3: Table view 2

The data contained in a table may consist of either text or values (typed directly in by
the user) or calculated values (formulas). The data is arranged in rows, otherwise
known as records.

2.2.3. Convert your range to a table

To create a table in Excel 2007 or 2010, select any cell within your range of tabular

HE

Table
data. Select the Insert tab and then selectthe ~  icon from the Tables group.

The following dialog box will appear, see Figure 4.

Alternatively using the keyboard select <CTRL>+<T>

-
Create Table el
Where is the data for your table?
My table has headers
[ OK. ] [ Cancel ]

Figure 4: Create Table dialog box
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Select the My table has headers check box if your selection includes headers. Select
A table has now been created. The appearance of your range of data will change to
alternate coloured column and filter arrows will appear in the header row, see Figure
3 and Figure 4 above.

At the top of your screen a new ribbon option will also have appeared named Table
Tools,Design.

2.2.4. Format your table

Once you have formatted your data as a table, you can change the appearance using
Table Styles.

Click anywhere within your table and from the Table Tools Design tab select a style
from the Table Styles tab. See Figure 5

Table Styles

Figure 5: Table Styles tab

2.2.5. Add a total row

Tables have a built in facility to add a total row.

Click anywhere inside the table and from the Table Tools Design tab select Table
Styles Options. Point and click in the box to insert a tick by Total Row See Figure
6

|:| Header Row |:| First Column

Total Row |:| Last Column
|:| EBanded Rows |:| Banded Columns

Table Style Options

Figure 6: Table Style Options

Totals will now appear, by default in the right-most column. The default calculation
for number values will be SUM and for text values COUNT.

To change the total from SUM to a different option, click in a cell in the total row. A
drop down arrow will appear. Select an alternative calculation function from the list.
See Figure 7

Rob Roy 21/01/2014 Food £17.00
Janine Brown 28/01/2014 Rent £20.00
Pamela Wright 04/02/2014 Food £18.00
Rob Roy 11/02/2014 Rent £14.00
Rob Roy 21/01/2014 Food £12.00
Pamela Wright ~ 28/01/2014 Rent £18.00
Zamela Wright 04/02/2014 Car £17.00
Samela Wright 11/02/2014 Food £12.00

Figure 7: Table totals

MNone
Average
Count
Count Numbers
Max
Min

StdDewv
Var

More Functions..
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2.2.6. Convert a table back to a range

It is advisable that before converting a table back into a range the table formatting is
removed.

To achieve this click anywhere inside the table.
Click Table Tools | Design | Table Styles | More | Light. See Figure 8

Figure 8: Remove Table Styles

To then convert your table back to a range, click anywhere inside the table and from
the Table Tools Design tab select Tools | Convert to Range. See Figure 9

id] Summarize with PivotTable
j-'1Flem|:an Duplicates
“-j Convert to Range

Taols

Figure 9: Convert to Range

Exercise 1: Convert a Range of data to a Table
Now look at this exercise (page 53)
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3 Filtering Data To Show A Subset

Rather than working with the entire list, you may wish to work with a subset. Excel
provides a simple way to show a subset of data in a list through the Data | Filter
options. When this is selected, drop-down arrows appear at each column label. The
AutoFilter feature is now active, and criteria can be specified (by selecting from the
suggested available values) to produce a subset of the list.

Remember if you have already converted your range to a table the filter arrows will
be available to you without needing to add them from the Data menu. All other filter
options will then be the same as working with a range.

You may like to bear in mind the following points when filtering a list.

¢ Filtering the list finds a subset of the data without moving or sorting it.

e Rows not matching the filter are hidden.

e Alist may be filtered according to the values contained in certain columns.
For example, you may like to view records whose Company Name is
Hardcopy Stores

e Alist may be progressively filtered to produce a smaller subset each time, until
the final subset is obtained. For example, you may like to view records whose
Company Name is PerfectWord and whose Amount is greater than £2500.

3.1. AutofFilter

A
INVOICE

14l

Figure 10: AutoFilter options

To use Excel’s AutoFilter feature to filter your data, place the cell pointer within the
list and choose Data | Sort & Filter | Filter.

Excel analyses your list and adds drop-down arrows to the field names in the header
row. By selecting a drop down arrow above a field the filter list options will change
according to the data type in the field you have selected.

Click the drop down arrow in the field of date you would like to filter. Uncheck the
Select All check box and check a box or boxes you would like to filter on. Click the

button.

Alternatively use the filters made available to you according to data type in the field
you are filtering on. The AutoFilter options available are Text filters, Number filters
or Date filters. See Figure 10Error! Reference source not found.

A B © u £

B C (8] E F INVOICE FIRM ~ COMPANY BUDGET
1 NUMBE~| DATE[~]coC~ e ]
A B (o} D E |
FIRM ~ COMPANY BUDGET 5] soroidest to Newest Equats
DATE ~ | COC ~ NAME hd CODE - AMOUNT INVDICE FIRM COMPANY BUDGET z
%l sortNewestto Oldest re.
SotAtoZ 440 £3.07 1 NUMBE~| DATE[-|COL~ NAME [-| coDE[~] AMO oty o
SortZto A 440 £312 41 Sort Smallest to Largest & Pins 440 ort by Color
N 440 £322 (2] coniaraestic by stores 440
Sort by Color 140 co 3 %1 sortLargestto smallest o Pine 0
Sort by Colc 3
440 118 ey celer ivord 440 Date Fifters
440 4,24 v Stores 440 .
4dn $0RA & Pins 440 Search (Al DE
Text Filters Equals.. h iared a4n (select Al)
- E Number Filters b Equals. 2014
Search o Does Not Equal... B B D13
a5 Search o Does Not Equal
¥ (elect Al) Begins With... 4 (Select Al ~ Greater Than. Next Month
[¥| Buttons &Pins =
Ends With... 1 1235 This Month
+[+#| Comp, Stares 5 1% Greater Than Or Equal To.
it Ltd Contains... B 1237 Less Than.. Last Month
~[¥ Hardcopy stores Does Not Cantain... 5 1238 Less Than Or Equal To.. Next Quarter
PerfectWord ? 1239 This Quarter
[ sitting Pretty Custom Eilter... #1240 Betuween.. R — Last Quarter
_—y 1241 [ ok | [ concer |
448 £4.20 iz Top 10
440 £1.40 -l 1243 Abave Average 25 1258 01/02/2014 B Siting
440 £34 =it id Below aversge 26 1260 06/02/2014 3 Hardeop
148 £4.05 27 1261 06022014 3 Hardcog
[ ok | [ canca | 445 cam [ ok | [ cancal Custom Filter... 2 1262 08/M2/2014 1 Buttons  Year to Date
) — tword 446 29| 1263 /022014 1 BWNGNS e intne period »

T barA
Ready | 73 | Custom Filter.
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On selecting an option available from the lists in Figure 10 a Custom AutoFilter
dialog box will made available for you to type in your criteria. See Figure 11

Custom AutoFilter

Show rows where:
AMOUNT
is greater than or equal to |Z| |
@ And or
is less than or equal to |z|

Use ? to represent any single character
Use * to represent any series of characters

[ 7 [
[=]
[=]

Figure 11: Custom AutoFilter dialog box

Alternatively if no relevant option is available on the AutoFilter facility then select
Custom Filter from the AutoFilter dropdown menu, which is located at the bottom

data type autofilter submenu. See Figure 10

3.2. Filter by selection

There is a time saver facility which is available for filtering your data and this is called
filter by selection. With two clicks you can filter your data.

Click into the field that you would like to filter and locate the value that you would like
to filter on, for example Hardcopy Stores, right click and select Filter | Filter by

Selected Cell’s Value. See Figure 12

Font
Jfx | Hardcopy 2y

e — -
(8]
COMPANY
NAME

Buttans & Pin:
Hardcopy store
Buttans & Pin:
PerectWord
Comp. Stores
Buttans & Pin:
PerfectWord
FixitLtd |1
Pertectord =
Pertectord
Sitting Pretty
Perfectord
Buttons 8 Pin: @
Hardeo stort.j’:
Hardcopy store=

& cut

Copy
Paste Options:

MNumber

Paste Spedial..
Insert..

Delete...

Clear Contents

Filter

sort

Insert Comment

Format Cells...

Fick From Drop-down List..
Define Name...

Hyperlink.

S oooY

G H

DISCOUNT |~ | TOTA~
£82.31 £2.98469
£8378 £3.032.22
£86.60 £3123.40
£35.90 £2.357.11

Filter by Selected Cell's Value
Filter by Selected Cell's Color

Filter by Selected Cell's Font Color

Filter by Selected Cell's Jcon
£0.00 £233.00
£19.67 £1.941.39
£0.00 £96.00

Figure 12: Filter by Selected Cell’s Value

3.3. Top 10 AutoFilter

This facility is available on Number Filters. The name is slightly misleading however
as it will filter both the highest and lowest or varying numbers of either items or

percentage in the selected field.

Click the drop down arrow to filter a number field, select Number Filters from the
list and then select Top 10 on the fly out menu. The below dialog box will appear.

See Figure 13
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Top 10 AutoFilter B
Show

Top =] (10 [5] rtems |

..................................

LN

Figure 13: Top 10 AutoFilter

Select Top or Bottom from the Show list, then select the number you would like to
display and select either Items or Percent from the final list. Click on

Exercises 2 & 3: Using AutoFilter, Filter by Selection
Now look at this exercise (page 56 & 61)

3.4. Filter by colour

If you have applied different cell or font colours or a conditional format, you can filter
by the colours in your data.

To filter by colour, click into the data select Data |Sort and Filter,

The AutoFilter feature is now active and drop-down arrows will appear above the
column headers.

Select the drop down arrow for the column you want to filter by.

Select Filter by Colour then select either Filter by Cell Colour or Filter by Font
Colour.

The types of colour options made available will depend on the types of formats you
have applied. See Figure 14

CODE ~ NAME |~ BUDGET COD-T
‘El Sort Smallest to Largest
ﬁl Sort Largest to Smallest

Sort by Color

% Clear Filter From "BUDGET CODE"

fom mn

Filter by Cell Color

[

Ma Fill v

Filter by Color

Mumber Filters

Search jel

Filter by Font Color

Automatic

I Fer e e )

OK Cancel
Figure 14: Filter by Colour

Exercise 4: Filter by Colour
Now look at this exercise (page 63)
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3.5. Clear filters

When a column of data has been filtered a filter icon will appear above the column
header. See Figure 15. To clear the filters from

AMOUNT |-T

Figure 15: Filter icon

To clear filters from a particular field select the column filter heading and select Clear
Filter From “Amount” (Field Name). See Figure 16

Figure 16: Clear Filter from column

To clear all the filters which have been applied, select Data | Sort & Filter | Clear
from the ribbon. See Figure 17

3| fa]z I, Clear

Zv |z|a J7 <

. J_ . {:} Reapply

ﬁl sort Filter \H:? S—
Sort & Filter

Figure 17: Clear all filters

3.6. Apply an advanced filter

The advanced filter command allows you to filter the list using complex criteria. This
command does not display drop down filter arrows in each column label. Instead,
search values have to be typed into a criteria range. Also, filtered records (that is,
those records matching the search criteria specified in the criteria range) may be
copied to a new location.

3.6.1. Setting up a criteria range

The criteria range is a separate area of the worksheet containing your search criteria.
It is usual to place the criteria range above the list but this is not compulsory. Do not

place the criteria range to left or right of the list as it may be hidden when the list is
filtered.

The top row of the criteria range contains the names of columns in the list that you
wish to search. The search values appear immediately underneath the column name.
A completely blank row in the criteria range will cause no records to be filtered. A
common method of inputting criteria headings is to copy the original column
headings, thus avoiding typing mistakes. See Figure 18
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A B

————p mvoIcE
1 HUMBER
2
3
4

> invoice
5 HUMBER
11 1240
14 1243
15 1244
16 1248
17 1246
21 1250
22 1251
29 1258
34 1264
40 1270
54 1284
62 1293
74 1308
80 131
82 1313
84 1315
93 1324
35 1326
an 120

C D E F G H
FIRM COMPANY
DATE CODE NAME BUDGET CODE = AMOUNT DISCOUNT
444
FIRM COMPANY

DATE CODE NAME BUDGET CODE_ AMOUNT DISCOUNT
047122008 1 A Daley Inc 440 £4,247.00 212.35
17/12/2006 5 Perfectivord 440 £4554.00 227.70
24/12/2006 5 Perfectivard 444 £4,351.00 217,85
25/12/2006 6 Sitting Pretty 444 £3127.00 93.81
27/12/2006 5 Perfectord 444 £4513.00 226,65
2040172007 4 Fixit Ltdl 440 £4273.00 21365
2040172007 4 Fixit Ltdl 444 £876.00 0.00
01/02/2007 6 Sitting Pretty 448 £4,335.00 216.75
1g/02/2007 1 ADaley Inc 444 £4,934.00 248.70
23/02/2007 2 Cornp. Stores 444 £3,650.00 108.50
18/04/2007 4 Sitting Pretty 444 £2,193.00 3290
07/05/2007 6 Sitting Pretty 442 £4,739.00 236.95
16/06/2007 3 Hardcopy stores 446 £4,263.00 212,65
01/07/2007 3 Sitting Pretty 441 £4,263.00 21315
10/07/2007 3 Hardcopy stores 448 £4536.00 226.80
140772007 3 Hardcopy stores 448 £4,926.00 246.30
10/08/2007 3 Hardcopy stores 444 £2.778.00 4167
22/08/2007 Cl Fixit Ltd 444 £1,082.00 1082
acmaming e Qithinri Dreth s Ana £oRANN a0 R

Column Headings

Figure 18: Advanced filter set up

TOTAL

>4000

TOTAL
£4,034 65
£4,326.30
£413348
£3.03319
£4,267 38
£4.05935

£876.00
£411825
£4.687 30
£3,54050
£2,160.11
£4,502.06
£4,040.35
£4,049.85
£4,309.20
£4.67970
£2.736.33

£1.07118
£9 FaA 0

3.6.2. Apply an advanced filter with complex AND/OR criteria

Comparison criteria are created by entering the values that you are looking for
immediately underneath the column heading in the criteria range. When the list is
filtered, each record in the list is compared to the value(s) that has been entered in the
criteria range. Records not matching the search criteria are hidden. For example, if
you were searching the list for records with a Budget Code of 440 OR 444 the

criteria range might look like this. See Figure 19

Budget Code

440

444

Figure 19: OR criteria example

Alternatively, if you were searching for invoices with a Budget Code of 440 OR
444 where Budget Code 444 has an Amount field greater than £4000, the criteria
range would look like this. See Figure 20

Budget Code | Amount
440
444 >4000

Figure 20: AND criteria example

Bear in mind the following guidelines when searching for records.

e C(riteria are entered immediately underneath the appropriate column heading
in the criteria range

e If the search contains two criteria that must be satisfied (a logical AND

condition) then the criteria are entered in the same row

e If the search contains two criteria, either of which may be satisfied (a logical
OR condition) then the criteria are entered in different rows (one below the

other).

11
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Figure 21: Advanced Filter dialog box

To filter data on the criteria in Figure 20. Enter the criteria in to the criteria range.
Click inside your list range and select Data | Sort & Filter | Advanced.

wiew View Developer

Al |Alz ’
Ll Z|a f

z Sort Filter (o
&l V2 Advanced || (

Sort & Filter

The Advanced Filter dialog box will appear. See Figure 21

A B [ D E F G H |
INVOICE FIRM  COMPANY BUDGET
1 NUMBER DATE  CODE NAME CODE AMOUNT Advanced Filter X

440 Action
444 >4000

ERFRILEY

@) Filter the list, inplace
Copy to another location
INVOICE FIRM COMPANY BUDGET .
5 |NUMBER DATE  CODE NAME CODE AMOUNT List range: $AS5:8H5113 (=]
B | 1235  181/2013 1 Buttons & Pins 40 [ $3.077000| | riteria range: |DATALSESLSFSD  [E)
7| 1236 20A1/2013 3 Hardcopy stores 440 E3Tze00 || s
3 | 1237 27A1/2013 1 Buttons & Pins 440 £3.22000 || =7 =
9 | 1233 27A1/2013 5 Perfectivord 440 £2.393.00 ey
10 1239 2711/2013 2 Corp. Stores 440 £1,153.00
1
5

1| 1240 04/12/2013 Buttons & Fins 440 £4.247.00 Cancel

12 1241 1Aze03 Perfectord 440 £2.663.00

The list range will already be defined because you clicked into this on your previous
step. Click into the Criteria range text box and select the range which contains your
criteria, in this case it is E1:F3. Click

The data will have now filtered according to the set criteria.

Exercise 5: Using the Advanced filter

Now look at this exercise (page 64)

3.6.3. Extract unique records in the same worksheet using an advanced

filter

A very useful feature of the advanced filter facility is its ability to extract unique values
from a list. This can create a master list of, for example Company Names and it is also
a way to check for spelling mistakes in a list if the unique list is then sorted.

To extract unique records and copy them to the same worksheet. Click into the
table/range of data and select Data | Sort and Filter | Advanced filter.

You then have an option to Filter the list in-place or Copy to another location.
Select Copy to another location

The List range is the column of data you would like to locate a unique set of records
from. The Criteria range can be left blank.

In the Copy to text box click into a cell in your existing worksheet and the cell
reference will be inserted for you.

Add a tick to the Unique records only check box and click the button. See
Figure 22

A unique list of Company Names will be placed into cell J1 and below.
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Advanced Filter (L2 [

Action

Eilter the list, inplace
@ Copy to another location

1

%‘]

List range: D5::D113

1

%‘]

Criteria range:

1

%‘]

Copy to: DATA115151|

| Unique records only

l OK ] | Cancel

5

Figure 22: Filter unique records only — same worksheet

3.6.4. Extract unique records to a different worksheet using an advanced
filter

If you want to copy a list of unique values to a different worksheet Excel will only
allow you to filter the data on the active worksheet from where the advanced filter is
activated.

Click into the worksheet where you would like your list to be placed. Select Data |
Sort and Filter | Advanced filter. The Advanced Filter dialog box will appear.

Select Copy to another location

The List range is the column of data you would like to locate a unique set of records
from. You will now need to click into the worksheet where your list is located and
select the relevant column of data which holds the field of data you are filtering on.

The Criteria range can be left blank.

Select the Copy to text box and the worksheet you originally selected will open. Click
into a cell in this worksheet and the worksheet and cell reference will be inserted for

you.
Add a tick to the Unique records only check box and click the button. See
Figure 23
A unique list of Company Names will be placed into worksheet sheet1, cell a1 and
below.
Advanced Filter [~
Action
Filter the list, in-place
Figure 23: Filter unique records only — different 3 Gy tax emicithes Incerfams
worksheet , —
List range: D5:D113 2.5
Criteria range: E
Copy to: Sheet116A%1 3
Exercise 6: Using Advanced Filter to Extract a 7] Unique records only
unique records list
oK l | Cancel |

Now look at this exercise (page 64) L
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4 Summarize your Data
4.1. Subtotals

The Subtotals feature is used to summarise data in a range. Excel calculates subtotal
values by using a summary function, such as Sum or Average and is not restricted
solely to adding up information. You can display subtotals using more than one type
of calculation in a range at a time.

In addition to providing subtotal calculations about the immediately preceding
section, Excel also allows Grand Totals for the whole range. Grand Total values are
derived from detail data, not from the values in the subtotal rows. For example, if you
use the summary function Average, the Grand Total row displays an average of all
detail data in the range, not an average of the values in the Subtotal rows. Excel
recalculates Subtotal and Grand Total values automatically as you edit detail data.

You do not need to enter formulas as subtotals are automatically inserted into the
range for you. Once subtotalled, you can use the outline feature see section 4.1.5, to
hide or show various levels of detail in the range.

It may be useful to bear in mind the following guidelines when subtotalling a range:
e The data to be subtotalled must be organised as a list with labelled columns

e Carefully plan how the data is to be subtotalled, as the information has to be
sorted before subtotals are applied

e When subtotalling, you must specify the following:
— what columns are to be grouped;
— the summary function(s) to be used;

— what values are to be summarised.

4.1.1. Sorting the data

Before a range can be subtotalled it has to be sorted appropriately. The subtotals are
inserted whenever the value in a specified field changes. To find the total sum of sales
for each Company Name you would first need to sort the Company Name field before
applying the subtotals.

You can also apply nested subtotals so the range must be sorted by the most
important field first followed by the second.
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4.1.2. Subtotal a range

Ensure you are working in a range of data and not a table. Click within your data and
look at the ribbon on the top of your screen. Check that the Table Tools ribbon is
not visible. If it is convert your table to a range using section 6 as a guide.

Sort your data according to your subtotal requirements, see section 4.1.1
Click into your range of data and click Data | Outline | Subtotal
The Subtotal dialog box will appear. See Figure 24

[ subtotal SR =)

At each change in:

COMPANY NAME [~]
Use function:

m [=]
Add subtotal to:

FIRM COCE -
COMPANY NAME
BUDGET CODE
AMOUNT
DISCOUNT

|TOTA 7
Replace current subtotals

[7] page break between groups

Summary below data

%)
c

m

o |

l Remove Al J [ CK ] [ Cancel

Figure 24: Subtotal dialog box
Tell Excel which column of repeating data you want to add subtotals to in the At each
change in.

In the Use function select a relevant function from the list, for example, Sum, Count,
Average.....

Click the check boxes alongside the relevant field names which you would like Excel to
perform the previously selected function on.

Ensure Replace current subtotals is selected, which will replace any previously
existing ones.

Click on
4.1.3. Nested subtotals

You may need to subtotal on more than one field and use a different function for each
subtotal. To achieve this you need to ensure your data is sorted according to what you
are subtotalling by.

For example, to analyse the value of total sales for a company and then count each
budget code per company, the range would be sorted by Company Name and followed
by Budget Code.

Perform your initial subtotal as per section 4.1.2. For example at each change in
Company Name sum the Total column.

Add a nested subtotal. For example the count of budget code per Company Name
Click into your range of data and click Data | Outline | Subtotal

The Subtotal dialog box will appear. See Figure 24
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At each change in choose the second field name that you want to subtotal by in this
example it would be Budget Code.

In the Use function select a relevant function from the list, for example, Sum, Count,
Average.....

Click the check boxes alongside the relevant field names which you would like Excel to
perform the previously selected function on.

Uncheck the Replace current subtotals check box. This is the box which will
ensure you do not overwrite the subtotals you initially applied.

Click on

4.1.4. Remove subtotals

To remove subtotals choose Data | Subtotal from the Outline category and
click on Remove All to remove your subtotals.

Exercise 7: Subtotalling data in a range
Now look at this exercise (page 69)

4.1.5. Hide and Show Detail

When subtotals have been applied, Excel displays the outline symbols, down the left-
hand side of the sheet see Figure 25, so that the organisation of the data is visible.
Clicking on the various outline levels allows all the data to be shown including
subtotals, the various levels of subtotals only, or collapses the data down so that only
the grand total shows. A brief summary is presented below.

e Row level number buttons: Click to display relevant levels of data in an
outline.

e Hide Detail box: This appears at the end of a level bar whose detail is
displayed. Click this symbol to hide the detail data.

e Show Detail box: This appears besides a summary row whose detail is hidden.
Click this symbol to show the detail data.

e The dots indicate the rows containing data.

Show detail box Row level number buttons
1]2] / A B

> 11E Stock Code | Description
+
= | 17 |MUO0 1018 Goggles
18 MUO00 1017 Gloves Latex Large
19 MUOD 1019 Sharpsafe box 13 Litre
+ | 20 MUOO 1020  Sharpsafe box 6.5 Litre
— 21
. . — ] - | 22 MU00 1002  Face mask disposable 3MB515
Hide detail box - | 23 MUO0 1003 Face mask disposable IMBT15
+ | 24 |MUOO 1004  Face mask disposable Paper
25 MU00 1005  Face Shield

Figure 25: Subtotals details view
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Exercises 8: Hiding and showing subtotal detail

Now look at this exercise (page 73)

4.2. Consolidate a range or table of data

Section 4.1 looks at using Excels Subtotals feature to summarise a range of data.
Subtotals will not however work with a table.

Data consolidation will allow you to summarise data in a range or a table, as well as
provide greater control over formatting your subtotal data.

You also do not need to pre-sort your data before using this feature.
If you are working with a range ensure all subtotals are removed. See section 4.1.4.

Click into the cell where you would like the summary to appear. This can be on the
sheet containing the data or a new worksheet.

Click on Data | Data Tools | Consolidate. (Figure 26)

=— = E=m s BaT
= BE = B= 2
EE] = — s Ly
Text to Remove Data Consolidate| What-If
Columns Duplicates Validation = Analysis =

Diata Tools

Figure 26: Data Tools Consolidate button

The Consolidate dialog box is displayed. (Figure 27)

r ~
Consolidate |. ? ﬂhJ
Function:

Sum EI
Reference:
ﬁ Browse...

All references:

Add
A Delete

Use labels in
Top row
Left column Create links to source data

e

Figure 27: Consolidate dialog box

Select a relevant function from the Function drop down list, the default is Sum.

Click into the Reference text box and select a range to consolidate. The left most
column of data will be the field which you are summarising, for example company
Name and the right most column will be the final field which contains the data you
would like to summarise.

Check the two check boxes Top row and Left column and click on Your data will
summarise similar to the example in Figure 28
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Figure 28: Consolodated data view 1

You will see that it has summarised all fields which were selected, some of which you
will not require. Delete fields which are not needed.

To insert additional totals alongside your summary, for example to count the number
of sales per company. Select a cell next to your current summary, E1, and repeat the
process, this time selecting Count from the Function menu.

Once again a surplus number of columns counting your data will appear, delete the
columns which are not required. You can also amend column headings with your own
text. Your summary may then look similar to below. (Figure 29)

A E c D E F
Murmber of

1 AMOUNT  DISCOUNT TOTAL  sales

2 |Buttons & Pins £31,863.00  £1,072.08 £30,790.93 13

3 |Comp. Stores £15.214.00 £341.02 £14,872.98 B

4 |Fixit Ltd £h2 49200  £1.626.93 £50.865.08 20

b Hardcopy stores E101,663.00  £2.837.91 £98,625.09 43

b |Perectord £27.892.00  £1,006.92 £26,885.09 10

7 |Sitting Pretty £41,01400  £1,504.15 £39,509.86 16

g

Figure 29: Consolodated data view 2

Exercise 9: Consolidate data
Now look at this exercise (page 74)

IT Learning Programme 18



TMSE3 Organising and Displaying Data

5 Charts
5.1. Using charts

A chart is a graphic representation of worksheet data and is particularly useful for
‘spotting’ trends or visualising relationships within your data.

In Excel, data already set out in a worksheet can be presented as a chart, whether the
cells contain constant values or calculations. A chart may be created as a new sheet in
a workbook (a chart sheet) or as an embedded chart on the same sheet as your
workbook data. An embedded chart is useful because both the chart and the data may
be viewed at the same time.

H Pointl

H Point2
® Point3

m Point4

Jan Feb Mar Apr

Figure 29: A column chart

5.2. Creating a Chart from Worksheet Data Using the Charts
Tools
The simple procedure to create a chart is to pre-select the data and choose the
appropriate chart type from the Quick Analysis Tool to the right of the chart. Every

chart type category has several sub-types, so it is interesting to explore what is
available.
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A B C D E F G H

1 |Wales

2

3 |Location| Jan Feb Mar Apr Total | Average

4 |Point 1 82.8 50.9 71.6 74.6 279.9 70.0

5 |Point 2 68.4 86.3 67.2 64.8 286.7 711.7

6 |Point 3 40.4 93.4 53.9 72.2 259.9 65.0

7 |Point 4 717.2 77.1 4.6 BE.l_ 325.0 81.3

8 |Total 268.8 307.7 277.3 297.7 |§|

9 |Average 67.2 Te 0 a0 d 148

10 FORMATTIMNG CHARTS TOTALS TABLES SPARKLIMES

11

z i b k< Bl
Clustere... Line Clustere... Line Stacked.. More...

14

15
Recommended Charts help you visualize data.

16

Figure 30: Select the data to be plotted and the chart type

5.3. Keystroke F11 for Creating a Chart

A useful keystroke if you are creating a number of charts is F11. First select the

range(s) of data to be included, and then press F11. A simple chart is immediately

created on a new chart sheet, based on the selected data, using all the default settings.
5.3.1. Exercise 10: Creating charts

Now look at this exercise (page 69).

5.4. The Chart Tools for Working on Chart Objects

Once a chart has been created, two additional ribbon tabs appear on the toolbar 1.
These are Design, Layout and Format tabs. Each tab contains several options to
customise a chart.

|
CHART TOOLS

DESIGN FORMAT

Figure 31: Chart ribbon tabs
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H ©- = CHARTTOOLS
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER MNuance PDF DESIGMN FORMAT
® —— e
b el T =
Add Chart Quick  Change i I e ||| ||| ||| ||| —— - Switch Row/ Select Change Move
Element - Layout~ Colors~ Column Data  Chart Type Chart
Chart Layouts Chart Styles Data Type Location

Figure 32: Chart Design tab

From the Chart Design tab, you have the option to change the chart type, chart data,
chart style as well as the location. You are also able to add chart elements to the chart
i.e. Title, legend and data labels, you can move the chart location (so that the chart is
on its own data sheet rather than embedded into the data sheet.

FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER Muance PDF DESIGM FORMAT
Chart Area M SN L2 Shape Fill - I Align - fl762em =
%4 Format Selection O dl- E - L¥ Shape Outline = A A A - ,,\\ B ;l] 762 :
] Reset to Match Style ALLF ¥ Shape Effects - - DQ Selection Pane woy[127em
Current Selection Insert Shapes Shape Styles ] WordArt Styles ] Arrange Size ]
Figure 34: Chart Format tab
The Chart Format tab, contains more options to format the chart objects, i.e. change
the size of the height and the width of the chart, change the colours of the
bars/segments of the chart, allowing individual chart objects can be altered. In
addition, chart annotation can be performed easily, e.g., add textbox, arrow or picture
to the chart.
5.5. Rearranging the Chart
The Chart Design tab of the ribbon has some useful tools for changing the overall
appearance of a chart.
)
«w is used to move a chart between being embedded on a worksheet or having its own
chart sheet.

Choose where you want the chart to be placed:

JJ_J,J (%' New sheet: |Scoﬁand_chart

|l ! " Objectin: IScoﬁand j

Figure 35: The Move Chart dialog
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Chart type = is used for changing between bar chart, column chart, line chart, pie

Chart Type

chart etc. Different chart types are suitable for different kinds of data, so it is worth
experimenting to find the type that presents your data best.

Faii

Switching the data series between row and column _ = may make the chart easier

Row/Calumn

to understand.

A variety of chart styles and colour schemes are available, in the Styles gallery. Even
more colour schemes are shown if you click - :

Chart Styles

Figure 36: Chart Styles Gallery

Exercise 11: Rearranging the chart
Now look at this exercise (page 79).
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6 Working on Individual Chart Objects

A chart is made up of many parts or objects, such as the axes, titles, data series (made
up of data points), plot area etc.

To know the name of each object, move the mouse pointer over the object and wait a
moment: a yellow ScreenTip will appear.

These can usually be rearranged or formatted separately. Simply select any object on
the chart and click #; format selection on the Chart Tools | Format Selection tab of

the ribbon. The Format Plot Area Options dialog box contains valuable options that
belong to the chosen object. Remember that you are changing the appearance, not the
values plotted.

Format Plot Area v X

PLOT AREA OPTIONS ¥

4 FILL

Mo fill

® Solid fill
Gradient fill
Picture or texture fill
Pattern fill

Automatic

Color & -

Transparency | 0%

4

I BORDER

Figure 37: The Format Chart Area dialog

6.1. Selecting On a Chart

Once selected, a chart object can normally be edited, moved, resized, formatted or
deleted.

6.1.1. Selecting Parts of a Chart

To select any chart object, simply position the mouse pointer over the object and click
once. Blue object handles appear to indicate that the object has been selected.

The name of the part currently selected is also displayed in the Chart Elements drop-
down control at the left end of the Layout and Format tabs of the ribbon
Plot Area - . Elements like the chart title, the legend, and the axis titles can all

be selected using this Chart Elements control.

6.1.2. Selecting a Data Series or a Data Point

Click once on a data line or one of the columns, bars etc. to select a whole data series.
Just a few blue handles appear to indicate which series has been selected. Click again
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to select an individual data point. More handles appear on the selected data point
only.
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Figure 38: Blue handles show a series selected then one data point selected

.....

Deselecting a Chart Object

To deselect the chart object, either press ESCAPE or click away from the object. Beware
that another object may then be selected by accident.

6.2. Moving a Chart Object

Some chart objects can be moved by selecting then dragging. Beware that individual
data points can also sometimes be dragged - the values set in the worksheet are
adjusted accordingly.

6.3. Resizing a Chart Object
Some chart objects such as the legend can be resized by dragging black handles.

6.4. Deleting A Chart Object

Once an object has been selected, pressing DELETE will delete the object. If you delete
something by accident, immediately undo.

6.4.1. Exercise 12: Selecting and resizing chart object

Now look at this exercise (page 80).
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7 Formatting a Chart
7.1. Formatting Parts Of A Chart

Excel has very powerful chart formatting facilities. You can change the appearance of
the entire chart or various parts of the chart to suit your requirements. For example,
you can change the font, size, appearance, colour of the text, colour and pattern of
shading to your chart titles, axes, data point and so on. Some ideas are presented
below.

7.1.1. Formatting Using the Formatting Buttons

The formatting buttons on the Home tab of the ribbon may already be familiar. Use
the ScreenTips and Help to learn about any which are unfamiliar. As with any
Windows formatting action, first select the object to be changed, then click the chosen
tool.

These buttons become available as appropriate, depending on the selected chart
object. For example, a data column can have its fill colour changed, whereas the text
of a title can have extensive font formatting with changes to typeface, font size and
colour, bold or italic faces, alignment and so on.

7.1.2. Formatting Using the Format Tab of the Ribbon

The Chart Format tab appears along with the Chart Design, when a chart or part of
a chart is selected. This offers further formatting options.

H ©- = CHART TOOLS
FILE HOME  INSERT  PAGELAYOUT  FORMULAS ~ DATA  REVIEW  VIEW  DEVELOPER  NuancePDF  DESIGN  FORMAT
i w il Dl |

Add Chart Quick Change |||||||||l| I||||||H.I| Ii“H Il I“ﬂl ||| |||I|||“||| i -

Element = Layout~ Colors~
Chart Layouts Chart Styles

Figure 39: Shape Styles

7.1.3. Formatting Using the Format Dialogs

Further options are found in the Format dialogs. The options vary, depending on the
chart part that is selected. There are several ways to display the relevant Format
dialog:

e double-click part of a chart to show the relevant Format dialog which appears to
the right had side of the chart

e right-click part of a chart to show a context menu including the command to
Format [the kind of object selected]

e select part of a chart and click 3 Format selection on the Format tab

When the dialog is displayed, confirm that its title shows the part of the chart you
intended to work on. Then choose a category from the list on the left, and make
changes to the settings shown on the right.

7.1.4. Exercise 13: Formatting the chart

Now look at this exercise (page 81).
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7.2. Controlling the Axis Scale

When a chart is created, Excel chooses each axis scale i.e. the maximum and
minimum values shown on the axis. These values may not be appropriate, especially if
you are creating a set of charts which are to be compared. You can set the values on
the axis scale, using the Axis Options from the Format Axis command.

Format Axis v
AXIS OPTIONS ¥  TEXT OPTIONS
S O o= ol
4 AXIS OPTIONS
Bounds
Minimum 0.0 Auto
Maximum 1200 Auto
Units
Major 200 Auto
Minor 40 Auto
Harizontal axis crosses
® Autpmatic
Axis valug 0.0
Maximum axis value
Display units Nane A
Logarithmic scale 10
Walues in reverse order
I TICK MARKS
I LABELS
I NUMBER

Figure 40: Setting an axis scale

7.3. Labelling Parts of a Chart

Once the chart has been plotted, the next step is to label it. Depending on the type of
chart, any of the following might be appropriate: chart title, legend, category and
value axis labels, data labels, and annotations.

Labelling (chart title, labels on the horizontal and vertical axes, the legend and many
other labels) can be added from the Layout tab of the ribbon.

A chart title usually appears at the top centre of a chart. Each axis should also usually
have a title, specifying what is plotted and, preferably, the units.

7.3.1. Exercise 14: Making a chart more readable
Now look at this exercise (page 83).

7.3.2. Data Labels

Data labels display data values or text next to each data point on the chart. These are
shown using Add Chart Element | Data Labels | More Options on the Chart
Design tab of the ribbon.
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Format Data Labels v X

LABEL OPTIONS ¥  TEXT OPTIONS
O O o=l

4 LABEL OPTIONS
Label Contains

Value From Cells
Series Name
Category Mame
+| Value
~| Show Leader Lines
Legend key
Separatar . bl
Reset Label Text
Label Position
Center
Inside End

Inside Base

® Qutside End

- NUMBER

Figure 41: The Format Data Labels Dialog

7.3.3. A Legend

Alegend is a list of the data series shown in a chart, with the colours or line styles that
represent each.

To insert a legend, click Add Chart Element | Legend | More Options from the
Design tab of the ribbon and select the preferred position of the legend. To delete the
legend, simply select it and press DELETE. To format and customise a legend, select
the legend and click @y rormat selection on the Chart Format tab of the ribbon.

7.3.4. Data Table

A data table is a table showing the values plotted, shown alongside the chart. A data
table can be shown/hidden using Add Chart Element | Data Table | More
Options on the Design tab.

7.3.5. Gridlines

Some charts are easier to understand if gridlines are shown. You can insert/remove
the gridlines using Add Chart Element | Gridlines | More Options on the
Design tab, select No Line from the Format Major Gridlines on the right hand
side of the chart.

7.3.6. Exercise 15: More chart options

Now look at this exercise (page 76).
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8 Working With Data Series in a Chart

8.1. Axes Options

Add Chart Element | Gridlines | More Options on the Design tab gives you
control over the vertical axis and/or the horizontal axis. A labelled axis is usually
needed, to give value to the chart data points, but you have a choice over where the
labels are drawn.

8.1.1. Axes on a Chart: Naming?

Various conventions are used for naming the axes of a chart.

Excel specifies the main axes of a chart as “horizontal” and “vertical”. These are
sometimes referred to as the “X” axis and “Y” axis respectively.

In a chart such as a column chart, the categories (labels) are shown along the
horizontal axis and the values (numbers) are shown vertically. However if the same
chart is converted to a bar chart, the categories appear stacked vertically and the
values are plotted horizontally across the page.

Of course some chart types, such as a pie chart, do not have axes in this sense at all.

8.2. Plotting Non-Adjacent Areas

The worksheet data used to plot a chart is typically contained in one contiguous range
on the worksheet. However it is possible for a chart to draw data from several non-
adjacent areas, even from different worksheets.

A new chart can be created which draws data from 2 or more non-contiguous
(separate) ranges, provided the ranges are all on the same worksheet.

The procedure is:
1) Select one range of cells
2) Hold CTRL and select another range of cells on the same worksheet

3) Use the Insert tab of the ribbon to insert one of the chart types

8.2.1. Exercise 16: Plotting non-adjacent ranges
Now look at this exercise (page 87).

8.3. Inserting More Data into an Existing Chart

Once a chart has been plotted, you can extend the chart to include new data. This is
useful if you wish to draw together data from other worksheets and show it all
together in one chart.

On the Design tab of the ribbon you have an icon called Select Data which displays
a dialog where you can add additional data series (and edit or remove them). This is
also the place to adjust if necessary the labels for the horizontal axis, or to edit the
range where these labels are to be found.

IT Learning Programme 28



TMSE3 Organising and Displaying Data

select Data Source |
Chart data ranage: |=Scotiand! SAS3:5A57 Scotland! $G$3:8GS7 Eﬂ
_ﬁ_,j Switch Row /Column |
Legend Entries (Series) Herizontal (Cateqory) Axis Labels
5 add S Edt X Remove & Edit
Average Point 1
Point 2
Point 3
Point 4
Hidden and Empty Cells | 0K I Cancel |

Figure 42: The Select Data Source dialog

Series name:
|=Englan-:|! SAS3 ﬁ = England
Series values:
=
| England!$6$4:6¢71 & =63.18,58.21, ...

QK Cancel

Figure 43: Adding A New Data Series

8.4. Adding a Data series by Copy/Paste

An alternative method of adding extra data to an existing embedded chart is to select
the extra range of cells on the worksheet, then Copy and Paste them onto the chart.

8.5. Deleting a Data Series

To remove an unwanted data series from a chart, select the appropriate data series on
the chart and press DELETE. If you make a mistake, immediately press CTRL + Z or
choose Undo. The data remains in the worksheet.

8.5.1. Exercise 17: Adding more non-adjacent ranges
Now look at this exercise (page 88).
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8.6. A Chart with Mixed Types
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Figure 44: A Chart with Mixed Types

A chart can combine two or more types of chart, so it illustrates different types of
information simultaneously. For example, one data series can be shown in columns
and another data series appears as a line on the same chart.

This is a good way of making one data series stand out, especially if it is a different
kind of data from the rest.

This is done by selecting the data series on the chart, then changing the chart type

using == on the Chart Design tab of the ribbon.

8.6.1. Exercise 18: A chart with mixed types

Now look at this exercise (page 91).

8.7. Secondary Axis on a Chart

If one data series on a chart has values that are quite different from the other series,
or if it is a different kind of quantity, then the primary vertical axis is not suitable. A
secondary axis allows one series to be plotted over a different range from the main
chart.

The setting for a secondary axis is in the Format Data Series dialog, in the Series
Options category.
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Format Data Series 2lx|
- - ] . .
Series Options Series Options
Fil [~ Series Overlap
Separated Overlapped
Border Color " J .
Border Styles IU%
Shadow - Gap Width
Glow and Soft Edges Mo Gap )I Large Gap
3-D Format IISD%
[ Plot Series On
' Primary Axis
¥ Secondary Axis

Figure 45: The Format Data Series dialog

Such a data series would usually be presented with a different chart type, so that it
stands out from the rest of the data series.

It is usually important then to specify a suitable vertical axis scale, and alter the
legend to make the series clear.

8.7.1. Exercise 19: A combination chart with a secondary axis
Now look at this exercise (page 93).
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9 Charts With Lines

One of the tricky questions with charting is the distinction between a Line chart and an
XY Scatter chart. The key difference is the treatment of the (X) category data axis.

A Line chart treats the X axis data as non-numeric, category information equally
spaced out along the horizontal axis. This is good for category data such as text labels
(text values like Qtr1, Qtr2, and Qtr3) but can produce unexpected results when the X
values consist of numbers.

A Scatter chart has two value axes, showing one set of numerical data along the X-axis
and another along the Y-axis. It plots each value as a single data point, so the points
appear at uneven intervals, maybe in clusters.

9.1. When to Use a Line Chart

A Line chart can display several categories of data, set against a common scale. As a
general rule, you may want to use a Line chart if your data has non-numeric X-values.
For numeric X-values, consider using a Scatter chart.

For example, Figure 46 shows the number of times certain courses were run at

IT Services in the years 2003 and 2004. The horizontal axis shows the types of courses
run; the course types are evenly spaced along the horizontal axis. The figures for the
years 2003 and 2004 are shown as separate series, so they can be compared. This line
chart is easy to read and shows clearly the important data including the course titles
shown on the horizontal axis.

Line charts display lines joining a set of data points, with or without data markers.
Unlike Scatter charts, Line charts can even be displayed with a 3D visual effect.

Frequency of courses

[
o

=$=Year 2003

== Year 2004

Frequency
o - ~n w & un o ~ o i)

Figure 46: Line chart

9.1.1. Exercise 20: Create a line chart
Now look at this exercise (page 95).

IT Learning Programme 32



TMSE3 Organising and Displaying Data

9.2. When to Use a Scatter Chart

Scatter charts are commonly used for displaying and comparing numeric values such as
scientific, statistical, and engineering data. The more data included in a Scatter chart,
the better the comparisons that can be made.

Insert Page Layout Formulas Data Review View Developer Team

EE ) i — 1 i ey I
dgn YR e ke DSl ® VA T
Yicture Clip Shapes SmartArt Screenshot | Column  Line Pie Bar Area |Scatter| Other Line Colum
Art - - - - - - - -~ |Charts =

Hlustrations Charts Scatter sparkli
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Figure 47: Creating a Scatter Chart

A Scatter chart can be used to show similarities between large sets of data. Rather than
showing the differences, a Scatter chart can point out interesting similarities.

In the example shown in Figure 48, the same data has been plotted (as used in) but as
pairs or grouped sets of values. In this example the paired data is numeric data, the
number of courses run in the two years 2003 and 2004. Each point represents a
different course.

If a data point lies on the diagonal line from (0, 0) to (10, 10), the y = x line, then it
represents a course that was run the same number of times in both years.

Data points lying below the line were run more often in 2003 and points above the line
were run more often in 2004.

In a scatter chart the independent scales can be adjusted to reveal more information
about the data values.

(Exercise 12 below gives the steps for drawing a line y=x onto a data chart.)
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Figure 48: Scatter chart

9.2.1. Exercise 21: Create a basic scatter chart
Now look at this exercise (page 96).
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9.2.2. Exercise 22: Create another scatter chart
Now look at this exercise (page 98).

9.2.3. Exercise 23: Improve the scatter chart with a line (Optional)
Now look at this exercise (page 99).

IT Learning Programme 34



TMSE3 Organising and Displaying Data

10 Histograms

A histogram is a chart that shows a visual impression of the distribution of data
across categories and is commonly used to summarise a long list of data.

Histograms are usually drawn with vertical columns. The horizontal axis is organised
into data ranges, and each column shows the number of data points falling into each
range. For example, data of family incomes could be grouped into £5,000 intervals,
and show the number of households whose income falls in each range.

10.1. Common histogram shapes
When you create a histogram it will probably be defined by one of four overall shapes:
e Symmetric
e Skewed right (positively skewed)
e Skewed left (negatively skewed)
e Multiple peaks
We will look at these types below

10.2. Planning the data for a histogram

We have said a histogram shows a visual impression of the distribution of data or how
many observations (data points) fall in various ranges of values. So first you have to
decide what your range of values (bin ranges) are.

A good way to choose bin ranges is to divide the range of values (smallest - largest)
into equally spaced categories. One example could be to work with all IQ values
between 49 and 168. So bin values for this could be like those in Figure

A B 5
~ |Bin ~
561 60
137 70
50 80
125 S0
141 100
153 110
156 120
138 130
10 9 72
11 10 62
12 11 88
13 12 62
14 13 51
15 14 92
16 15 60
17 16 74
18 17 123
19 13 100
20 19 109
21 20 115
22

=]
Is]

0N o e W (N

0N e ! B w s
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Figure 50: Histogram data

Note that the bin numbers must be entered in ascending order and although ranges
do not have to be evenly spaced, beware as unequal ranges can be misleading to the
audience.

If you don’t enter bin numbers on the worksheet the Histogram tool automatically
creates evenly distributed bin intervals however, these bins may not be useful so it is
recommended that you use your own bin numbers.
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10.3. Create a Histogram

Before a histogram can be created you will need to install the Data Analysis
ToolPak. To install this please follow the instructions in section

e To create the Histogram, click into your data and select Data | Analysis |
Data Analysis | Histogram then click and the Histogram dialog box will
appear, see Figure

-
Histogram

Input

K
Input Range: sBs1:88521

nl [mn
] &)
IIIE

) Cancel
Bin Range: SC51:5C59| B

Hel
Labels gep

i#

Qutput options

") Qutput Range: 575
@ MNew Worksheet Ply:

~) New Woarkbook
[ Pareto (sorted histogram)

|:| Cumulative Percentage
Chart Qutput

Figure 51: Histogram dialog box

e TheInput Range relates to the input data that you want to analyse in the
example we are using here it relates to the IQ values in column B.

e The Bin Range relates to a range that contains an optional set of boundary
values that define the bin ranges. In this example the values are in column
C.

e If the first row or cell in the column of your input range contains labels,
select the Labels check box.

In Output options, there are three further options. If Output Range is selected,
a cell reference is required of where you want the histogram frequency data and
chart to be placed.

e Click into the Chart Output check box and then select

Your data will then be summarised as a frequency table and a histogram chart.
See Figure

E F G H 1 1 K L M N

Bin Frequency
60

70

80

90

100
110
120
130

Histogram

M Frequency

N oR R RN N W W

Maore

Frequency
O o koW M

60 70 80 90 100 110 120 130 More
Bin

Figure 52: Histogram frequency table and chart
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The Histogram data analysis tool works on a list of data values, grouping them into
ranges. It counts the frequency of data points in each bin range, and optionally
presents the result in a chart. Note that these frequency counts are not dynamic: if the
data changes, you must re-run the Histogram analysis.

10.4. Analysis ToolPak

Before you can use the Histogram tool, you will need to install the Analysis ToolPak
Add-in.

Click on the File tab then select Options in the left panel, see Figure

| Bookl - Microsoft Excel o B 2R
Home Insert Page Layout Formulas Data Review View Muance PDF 'e

[l Save

Recent Workbooks Recent Places
Save As ) .

To browse for a file, click Open.
55 Open
[ Close
Info
New
Print
Save & Send
Help

|
9 Exit |
O Quickly access this number of 4
Recent Workbooks: . L5 Recover Unsaved Workbooks

Figure 53: File Options screen

Select Add-Ins and then click shown at the bottom of the window in Figure
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Figure 54: Excel Options dialog

Select the Analysis ToolPak check box in the Add-Ins available on the Add-Ins
dialog box as shown in Figure

-
Add-Ins

Add-Ins available:

Analysis ToolPak - oK

[ analysis ToolPak - vBA
|:| Euro Currency Toaols
[ Realstats-2007

[ solver Add-in

Cancel
Browse. ..
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engineering analysis

b

Figure 55: Add-Ins Analysis ToolPak

Select [OK], wait for Excel to finish configuring. The Analysis ToolPak can now be
located in Data | Analysis | Data Analysis see Figure
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llﬁ Data Analysis

Analysis

Figure 56: Data Analysis ToolPak

On selecting Data Analysis the Data Analysis dialog box

Analysis Tools menu select Histogram and then click on

ears and under the

-

Data Analysis - J L2

Analysis Tools
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Exercise 22: Install the Analysis ToolPak Add-in

Page 46 — instructions on how to install the Analysis ToolPak Add-in

Exercise 23: Creating a histogram

Now look at this exercise (page 102)
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11 Sparklines

Sparklines are tiny charts that fit into a single cell in a worksheet. They can be used to
highlight trends or changes that may not be easily spotted in the data itself or if there
is too much data to plot in a single chart. An example of a data set and singular
graphs made from this data can be seen below in Figure 57: Data set and singular

graphs
1
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Figure 57: Data set and singular graphs

Sparklines can be easily added with just a few clicks of the mouse. They are dynamic
and update automatically when the source data changes.

11.1. Insert Sparklines

e Click into a cell to the right of your row of data, in the above example this

would be N2

e Click on Insert | Sparklines | Line from the ribbon. The Create
Sparklines dialog appears. See Figure

Create Sparklines

R===)

Choose the data that you want
Data Range: | B2:M2Z|

Choose where you want the sparklines to be placed

)

Location Range: | §M§2 [3-5
[ Ok ] [ Cancel
Figure 58: Create Sparklines dialog
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e Clickin the Data Range and select the row of data you would like to create
the Sparklines from, the Data Range, using the example in Figure 59 would
be B2:M2.

e Click the [OK]|button. A Sparkline will appear in cell N2.
e AutoFill the Sparkline to the rows below.

You can add different Sparkline graphs to different columns, see Figure below.

A =] C B} E F G H | J K L 1A M o [

Il Company pd Jan RdFeb RdMar RdApr RAdMay Ed.Jun Bd Jul M Aug RdSep AdOct RdNov RdDec §d

2 Buttons & Pins £1,386.99 £3207.19 E2639.80 £593262 £23300 £357.99 £2904.68 E233.00 £1.950.30 E46G7.30 £37123.40 E403465) ™ mll u em
3 Comp. Stores E34B.00 £3.91210 £1.394487 £3564060 £4563600 £1.741.47 £2452.60 £1.464.21 £2.641.30 £2,742.24 £2536.39 S~ Bl e ame

4 |Fixit Ltdd £4.935.35 £7864.20 £471027 £7.02668 £A.99460 £409952 £495.00 £947.00 £33686.27 £4726.40 £3993.80 F1663.95) " oleile e
5 |Hardcopy stores  £2,037.39 £3571.81 £515463 £9140.72 £2 32460 £7700.60 £46081.20 £4527.06 £490249 £63310 E270481 E3 73937 v _colllimm o
6 Perfecttord £3.276.66 £1,375.71 £1,05435 £27144.35 £1,28766 £428735 £2357.11 E2B4276 E4,326.30 £47133.45 ST e Rl

7 Plugs and Sockets  £3.855.10 £1.976.04 £1.056831 E270035 £2906871 £4737.03 £A46.00 £2736.33 £1.941.39 $46686.35 £303222 EBA7E70| ™" mecell o iall
8 Sitting Pretty £4118.25 E255017 E2TB01 £4680.21 £5287.05 £4049.85 £6,181.68 £415535 £848.25 E244576 £303319) — " sl .

Figure 59: Sparklines

Note that on selecting a Sparkline a new ribbon will appear, the Sparkline Tools
Design ribbon, see

o~ S & o Vicrosor ExcelW— T —
m Haome Insert Page Layout Formulas Data Review View Developer Design
1@2 vl B [E High Paint [ First Paint | | | | | | 2 Sparkline Color = S
[ Low Point [ tast point | | 1 '.I...I'|.| L I'l"'lll'l b I'l"'lll'l b I'l"'lll'l L I'l"'lll'l b I'l"'lll'l ~ | [ Marker Color - I ungroup
Edit Line |Column|Win/Loss _ Auxis
Data~ [C] Wegative Points = - (2 Clear ~

Sparkline Type Show Style Group

Figure 60: Sparklines Tools Design ribbon

11.2. Apply a common vertical axis to a Sparkline group

The Sparklines that are initially created provide a snapshot of a single row of data.
The minimum and maximum values are set based on each individual rows values.
Sometimes this may not be helpful and it will be appropriate to group the Sparklines
together and show them in proportion the full data set.

An example of this can be seen in the Sparklines originally created and has been
highlighted in Figure 61 below

M 8]

1

? Buttons & Fins £1,386.99 £322719 £263980 £593262 £233.00 £357.99 E2954.68 £233.00 £1.950.30 £4.687.30 £3123.40 £403485) " adl a men
3 Comp. Stores £340.00 £3812.10 £1.394.87 £364060 £4536.00 £1141.47 £245265 £1.464.21 £2541.30 £2742.24 £2535.38 A Bl e
4| Fiit Ltel £4.936.35 £7.064.20 £471027 £7.026.60 £6994.60 £409952 £498.00 £947.00 £3386.27 £4.72540 £3993.80 £1.603.89) - olele ome
5 Hardcopy stores  £2.037.39 £35671.01 £5.156463 E9148.72 £2.324.60 £7.76060 £4681.20 £4527.06 £4902.48 £69310 E2704.81 £3730.37| v ot lomm o
B Perfectéord £3,276.86 £1,375.11 £1.05435 £214435 £1,287.66 £4287.35 E2 35711 E2B42.76 £4326.30 £4133.45 T i el

7 Plugs and Sockets  £3855.10 £1.976.04 £1.058.31 £2,700.35 £2,90871 £4737.03 £646.00 £2736.33 £1,941.39 £4686.35 E3032.22 EEE75.70[ v ma sl maliall
& Sitting Prethy £4,118.25 £2550.17 £2160.01 £4680.21 £5,287.05 £4049.85 EB181.68 £4755.35 £848.25 £2,44576 £303319) — " meiialin

Figure 61: Snapshot of a single row of data in to create a Sparkline

From Figure 1 Buttons & Pins has sales of £5932.62 in April and Hardcopy stores has
£9148.72. Looking at the column Sparkline the sales column for April look similar for
both companies and therefore the Sparkline may be considered misleading.

The Sparklines can be grouped together and a common maximum and minimum
value can be set for all Sparklines. To achieve this:

e Click onto any of the Column Sparklines, on Figure 61 above this will be any
Sparklines in column O.

A thin blue line should appear around all the column Sparklines, this is because
Excel considers all Sparklines as a Sparkline Group so any changes that are made
using the Sparkline Tools Design will apply to all Sparklines in the group.
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e Click on Sparkline Tools | Design | Group | Axis drop-down, the below
menu will appear, see Figure 62: Axis drop down menu

A
%Ungroup
Hxis .
= o Clear =
Horizontal Axis Options
v | General Axis Type

Date Axis Type...
Show Axis ;
Plot Data Right-to-Left

Vertical Axis Minimum Value Options

v | Automatic for Each Sparkline
Same for All Sparklines
Custom Value...

Vertical Axis Maximum Value Options

v | Automatic for Each Sparkline
Same for All Sparklines

Custom Value...

Figure 62: Axis drop down menu
e Click Vertical Axis Minimum Value Options | Same for All
Sparklines

e Click Vertical Axis Maximum Value Options | Same for All
Sparklines

The Sparklines will then change, see Figure 63: Sparklines with same axis as
Sparkline group

A 5] C D E = G H | il K L 1A ] o

1

2 |Buttons & Ping £1,306.99 £3227.19 £2639.80 £593262 E233.00 E3IG799 £298469 EP3R00 £1,95030 £4.687.30 £312340 £4.03465) ~rr™ am amem
3 Comp. Stares £345.00 £3912.10 £1.384.91 £354060 £4536.00 £1.141.47 £2 45260 £1.464.21 £2.641.30 £2742.24 £2536.38 P e —
4 |Fixit Ltc! £4935.35 £70864.20 £4770.27 £7026.60 £6,99460 £409952 E498.00 £947.00 £3386.27 £4,725.40 £3,993.80 £1.68399) T oleie s
b Hardcopystores  £2.037.38 £35671.81 615463 £814872 £232460 £7 70060 £4681.20 £4627.08 £490249 €G30 £2 70481 £3738.37) e cosllliom
b |Perdecttord £3.276.66 £1,375.11 £1,054.35 £2144.35 1208766 £4208735 £235711 £2 64276 £4,326.30 £4,133.45 =T e mwm

7 |Flugs and Sockets £3656.10 £1.976.04 £1.088.31 £¢700.36 £290871 £4737.03 EG46.00 £273633 £1.941.39 £4686.356 £303222 £6676.70) " mmm—mn
8 |Sitting Prety £4178.25 £2560.17 £2160.11 2468021 £5,287.05 £4049.85 618160 £4715535 E848.20 £2.44576 £3.03379) — " = s .

Figure 63: Sparklines with same axis as Sparkline group

11.3. Deleting Sparklines
Sparklines can be deleted two ways.

e Delete the column of data where they are located.
OR

e Select the Sparkline group

e Click Sparkline Tools Design | Group | Clear | Clear Selected Sparkline
Groups

Exercise 24: Create Office 2013 Sparklines

Now look at this exercise (page 106)
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12 Exercises

Exercise 1

TMSE3 Organising and Displaying Data

Convert a Range of data to a Table

e (Create a table from an existing range — See Section 2.2.3
e Name your table - See Section 2.2.3

e Format the table - See Section 2.2.4
e Add totals and change the totals calculation - See Section 2.2.5
e Remouve table styles and convert the table back to a range - See Section 2.2.6

Task 1

This task is to convert your existing
data from a range to a table.

Step 1
Open Data1.xlIsx from the H:\ drive.

Click anywhere inside the list in the Sales 2013 worksheet.
Select the Insert tab on the Ribbon click Tables | Table.

FILE HOME FORMULAS

=L El e R

PivotTable Recommenfled Table

INSERT AGE LAYOUT DATA

ictures Online

PivotTabl Pictures @+ 7

Tables Illustrations Apps
B3 - fe || 2071172012

A B C D
1 INVDICE NUMBER DATE FIRM CODE COMPANY NAME
z 1235 18/07/2013 1 Euttons & Fins
3 I 1236 20011201 3_ 3 Flugs and Sockets
4 1237 27117203 1 Buttons & Pins
5 1238 27/07/2013 5 Perfactiford
B 1239 27/06/2013 z Comp. Stares

Convert a range to a table

Step 2

REVIEW

1?

Charts

E

BUDGET CODE

440
440
440
440
440

The Create Table dialog box will now appear.

VIEW DEVELOPER
- &%
AV Rl TR

3 My Apps ~ E Recommended - Lo- Pir

Charts

F

AMOUNT
£307
£312
£322
£239
£1,15

In the Where is the data for your table? Text box make
sure the cell reference is =$A$1: $H$109. By default, if you click
inside the list in the worksheet then the Create Table dialog

box will show the correct range automatically.

Click
Create Table I. ? &J
Where is the data for your table?
£H$109 F
[ oK ] | Cancel |

("

Create Table dialogue box
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Task 2
Name your table

Task 3
Format the table to a preferred style

Task 4

You require totals, add a total row to
your table

IT Learning Programme

Step 1

Give your table a meaningful name.

On the Table Tools | Design tab in the Properties section
click into the Table Name: box and type SalesData2013.

Ed9--a&-
m Home Insert Page Layout
Table Name: i3] Summarize with PivotTable

SalesData2013 j*"Remo\re Duplicates

T Resize Table | [ Convert to Range

Properties Tools

Name table

Step 1
To format your table you need to ensure that your table is selected.

Click anywhere within your data. If your table is selected the
Table Tools | Design will become available on the ribbon.

Select a style from the Table Styles tab.

Table Styles

Table Styles tab

Step 1

Currently your table does not contain any total rows. Tables have
a built in facility to add a total row, you do not need to insert a
formula.

Click anywhere inside the table and from the Table Tools
Design tab select Table Styles Options. Point and click in
the box to insert a tick by Total Row

|:| Header Row |:| First Column
Total Row |:| Last Column
|:| Banded Rows |:| Banded Columns

Table Style Options
Table Style Options
Totals will now appear, by default in the right-most column. The

default calculation for number values will be SUM and for text
values COUNT.
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Task 5

Insert further calculations to the totals
row

TMSE3 Organising and Displaying Data

Step 1
Add in the SUM of the Amount and Discount column and COUNT
the number of entries.

To add or change a total in the total row from click in a cell in the
total row and a drop down arrow will appear. Select either a new
or alternative calculation function from the list.

INT - | DISCOUNT v | TOTAL -

£876.00 £0.00 £676.00
£4.263.00 £210.20 £4.052.80
£372.00 £14.01 £357.99
£4.536.00 £0.00 £4536.00
£896.00 £202.90 £693.10
£4.926.00 £200.60 £4,725.40
£1.389.00 £101.34 £1.287.66
£1.065.00 E216.75 £848.25
£4.933.00 £246.65 £4,686.35

£2.746.00 £41.19 £2,704.81
£8.366.99 §4°61.749.01

None

Count Mumbers
Max
Min

Maore Functions. ..

Table functions list

Click into row 110 in the Discount column, click
on the drop down arrow to the right of the cell
and select Sum

Click into Amount total cell in row 110 and insert
a Sum total here too.

Click into Budget Code column, row 110 and
select Count from the drop down menu.

Your table total should look like below

v | BUDGET CODI| - | AMOUNT - | DISCOUNT - | TOTAL M

444 £4.536.00 £0.00 £4.536.00
446 £8496.00 £202.90 £693.10
446 £4.926.00 £200.60 £4.725.40
448 £1,389.00 £101.34 £1,267.66
446 £1.065.00 £216.75 £848.25
3 440 £4.933.00 £246.65 £4.686.35
440 £2.746.00 £41.19 £2,704.81

[ 108 | £270.138.00 £8.388.99] £261.749.01

Completed Table totals
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Task 6 Step 1
You want to convert your table back to a | It is advisable that before converting a table back into a range the
range. table formatting is removed.

Remove table styles and convert back to | Click anywhere inside the table.

arange Click Table Tools | Design | Table Styles | More | Light.
Remove Table Styles
To convert your Table back to a Range, click anywhere inside the
table and from the Table Tools Design tab select Tools |
Convert to Range.
id] Summarize with PivotTable
jﬂ Remove Duplicates
H—j Convert to Range
Toals
Convert to Range
You may notice that the total row (row 110) still appears at the
bottom of your data and a formula has been inserted.
Task 7 Step 1
Save your file Save your file to the H drive.
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Exercise 2 Using AutoFilter
e Apply an AutoFilter - See Section 3.1
e Filter using multiple criteria - See Section 3.1

e Apply a Custom Filter - See Section 3.1

Task 1 Step 1
Use the AutoFilter locate the sales for the Work on the file you previously saved, having completed
company Buttons & Pins. Exercise 1 (Datal.x1lsx) or if you did not manage to complete

the previous task open the file

Datal Exl Completed.xlsx

Step 2
Click any cell in your range of data. Select the Data tab then
Filter (from the Sort & Filter category). The AutoFilter

feature is now active and drop-down arrows appear on each
column label like below.

Formulas Data Review View Developer
o (Bl connections 4| TS f g % == = ‘EI 5 b
3 2 [ F = B B B & T

Refresh ﬂ, Sort Filter 7 Textto  Remove Data Consolidate What-If Grou
Allr = 7 Advanced | Columns Duplicates Validation = Analysis ~ -

Connedions Sort & Filter Data Tools
FectWord
B D E F G H

CODI~ COMPANY NAME - BUDGET CODI ~ AMOUNT |~ DISCOUNT [*| TOTAL |~

| Buttans & Pins 440 £3,077.00 £92.31 £2,95469
3 Plugs and Sockets 440 £3126.00 £93.78 £3.032.22
| Buttans & Pins 440 £3.220.00 £96.60 £3,123.40
3 Ferfectord 440 £2,393.00 £35.80 £2.357.11
2 Comp. Stares 440 £1.163.00 E1153 £1.141.47
| Buttans & Pins 440 £4.247.00 £212.35 £4,034 65

Click in the Company Name field, point and click at the arrow
in the heading and from the drop down list remove the tick from
Select All, insertatick to Buttons & Pins

A B [ 1] E F

1 INVDICE NUMBEF ~ DATE | FIRM CODI~| COMPANY NAME - BUDGET CODI~ AMOUNT

2 1238 18/07 4} Sortatoz 440 £3.077.1
3 1238 I PYRRNPEIN 440 £3.126.1
4 1237 2711 . 440 £3.220.0
5 1238 27jo7  FeribyCeler g 440 £2,393.1
3 1239 27406 440 £1.1631
7 1240 042 440 £4.247.1
[ 1241 11/08 440 £2.693.1
9 1242 1712 TedEilters g 440 £1.701.1
10 1243 RE70L B — B 440 £4.,654.1
1 1244 il W] (Select Al I' daa Eaaenl
12 1245 2512 r 444 £31271
13 1248 27/08 444 £45131
14 1247 1208 i+L]Comp. Stores 440 £33
16 1249 16101 : DPEI&E;‘,’M 440 £96 1
i 1250 20701 {-[JPlugs and Sockets 440 £4.2731
18 1251 2001 Ositing pretty 444 £876.(
19 1252 21111 448 £4.2041
20 1253 26/01 440 £1,4011(
21 1254 26/01 440 £348.1(
22 1258 28101 —_— 446 £4,058.(
23 1256 27402 [ coneer | 446 £4012(
24 1257 31401, 446 £3,3781
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Notice the list has now filtered and only records for Buttons &
Pins appear (the rest are hidden).. The total row is also still
visible and this is now totalling only the visible items.

Look at the row numbers, you will see that row numbers are
missing, which are the hidden rows.

A B © D E
1 INVDICE NUMBEF ~ DATE | ~| FIRM CODI~ COMPANY NAME-T BUDGET CODI - I
2 1235 18/07/2013 1 I Buttons & Pins ! 440
4 1237 271142m3 1 Euttons & Pins 440
7 1240 04/12/2m3 1 Buttons & Pins 440
14 1247 12/08/2113 1 Buttons & Pins 440
20 1283 26/0142M3 1 Euttons & Pins 440
28 1262 05/09/2013 1 Euttons & Pins 441
29 1263 11/02{2013 1 Euttons & Pins 442
30 1264 1241042013 1 Euttons & Pins 444
i1 1265 13/03/2013 1 Buttons & Pins 445
iz 1266 14/04/2013 1 Buttons & Pins 446
i3 1267 18/04/2013 1 Buttons & Pins 446
96 131 25/05/2013 1 Buttons & Pins 440
102 1337 17/06/2013 1 Buttons & Pins 440
110 Total 13

. . -
Also notice that a filter icon = has appeared above the
Company Name column to show this column contains filtered

data.
Remove the Filter from Company Name Step 3
(single column) To remove the filter from a single column, click into the column

Company Name and click on the drop down filter arrow. Either
select (Select All) from the column’s drop down list or select
Clear Filter From “COMPANY NAME” which has a clear

filter icon alongside. &

c D

E ~| FIRM |:|JD|v| COMPANY NAME-T|

4| sortatoz
%l sertztoa
Sort by Colar

K Clear Filter From "COMPANY NAME®

Text Filters
Search p

v (W] {Select Al

I Buttons &Pins

[ Comp. Stores

[ Fixit Ltd

[Hardcopy stores

[IPerfectword

[CIPlugs and Sockets

[sitting Pretty

All rows in the list should now be visible.
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Filter the list to show Comp. Stores Step 4
records with a budget code of 440. Select the drop down list for Company Name, select Comp.
Stores

Now select the drop down list for Budget Code and select the
code 440

The filtered data should only show the following 6 records.

A B C o E F

1 INVOICE NUMBEF | DATE ~| FIRM CODI~| COMPANY NAME-T| BUDGET CODI-T|  AMOUNT |~

[ 1239 27062013 2 Comp. Stores 440 £1,1653.00

21 1264 2640172013 2 Comp. Stores 440 £34a.00

61 1296 1640772013 3 Corp. Stores 440 £2,490.00

b2 1297 16/08/2013 3 Cormp. Stores 440 £1.479.00

(15} 1300 27/09/2013 3 Cormp. Stores 440 £2.6680.00

BB 13m 274102013 3 Comp. Stares 440 £2.784.00
Remove all Filters Step 5

To clear all the filters which have been applied, select Data |
Sort & Filter | Clear from the ribbon.

sl farz ] B Clear
2 Zla <

” {:» Reapply
¥ sort Filter | .
il Wz advanced

Sort & Filter

Use the data type filters to locate sales in Step 6

Quarter 1, for Amounts between £2000 | (lick into the Date column and from the drop down filter arrow
and £3000 for any Ltd Companies. select Date Filters | All Dates in the Period | Quarter
1.

A B C D E

1 INVOICE NUMBEE = |  DATE -T| FIRM-CONL>| COLMDARSY MAME.T BUDGET CODI

4] Sort Oidest to Newest Equals... 440
Z]  Sort Newest to Oldest Before.. 441
2
Sort by Color » After...
W Clear Filter From "DATE" Between..
Tomarrow
v | Date Filters g Today
Search (All) ’OE Yesterday
=[] (Select Al Next Week V| Quarteri
=] 2013 This Week Quarter2
&1 [IMarch
: W uarter3
w [ May Last Week Q
Next Month Quarter4
Thig Month January
Last Month Eebruary
Hext Quarter March
This Quarter April
—— May
Cancel Last Quarter
June
Mext Year
July
13 This Year
August
152 Last Year 9ust
140 September
E; Year to Date odteber
Py v | All Dates in the Period * Hovember
M 4+ M| Sales 2013 %3 =
Ready 2 of 108 records found | F3 | Custom Filter... December
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Step 7

Click into the Company Name column and from the drop down
filter arrow select Text Filters | Contains..

i © D E
TE|-T| FIRM CODI ~| COMPANY NAME-Y‘ BUDGET CODI ~ AMC
i8] sertatez 440
12] sotzton 4;1
Sort by Color ,

& Clear Filter From "COMPANY NAME"

v | TextFilters » Equals...
Search D Does Not Equal...
[ (select All) Begins With...
~DButtons &Pins Ends With...
[Pt Lid
[ JHardcopy stores v | Contains...
L[ Sitting Pretty

Does Not Contain...

Custom Filter...

Cancel

The Custom AutoFilter dialog will appear and in the empty
text box to the right of contains type Ltd.

Click on

Custom AutoFilter l P |G|

Show rows where:
COMPANY NAME

containg |Z| Ltd |E|
@and Oor
] [=]

Use ? to represent any single character
Use * to represent any series of characters

Step 8

Now click in the Amount column and from the drop down
list select Number Filters | Between

E F c ¥
:IAME-Y BUDGET CODI ~ AMOUNT -T| DISCOUNT |~ TOTAL ~
14]  Sort Smallest to Largest £37.44 £2 458 5F
V2| sort Largestto smalest £34.29 £2.25171

£71.73 £4.710.27
Sort by Color 8

W Clear Filter From "AMOUNT"

V| Mumber Filters 8

Equals...
Search o Does Not Equal...
[ (select All Greater Than...
gggg?nn Greater Than Or Equal To...
[ £2,496.00 Less Than...
gn,mz‘nn Less Than Or Equal Ta...
e 7 s

Top10..
Above Average

Below Average

Custom Filter...
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Step 9

The Custom AutoFilter dialog will appear again. In the
empty text box to the right of is greater than or equal to
type 2000 and in the text box to the right of is less than
or equal to type 3000

Click on
r ~
Custom AutoFilter l ? i:h]
Show rows where:
AMOUNT
is greater than or equal to |Z| 2000] |Z|
@ And Or

is less than or equal to |Z| 3000 |Z|
Use ? to represent any single character
Use * to represent any series of characters

OK ] | Cancel |

Your filtered data should look like the example below.

A B C O E F
1 INVOICE MUMBEF ~ DATE|-T| FIRM CODI *| COMPANY NAME-T| BUDGET CODI ~ AMOUNT |-T C
43 1277 22/03/2013 4 Fixit Ltd 440 £2 496,00
45 1279 30/03/2013 4 Fixit Ltd 441 £2.286.00
110 Total 2 £4,782.00
Step 10

Remove the filters.

Clickon Data | Sort & Filter | Filter to remove the drop
down arrows for the column headings.

Save the file.
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Exercise 3 Filter by Selection and Top 10 AutoFilter

. Apply a Filter by Selection - See Section 3.2
. Apply a Top 10 AutoFilter - See Section 3.3

Task 1 Step 1
You would like to quickly see how many | Work on the file you previously saved, having completed
companies received zero discount. Use Exercise 2 (Datal . x1sx) or if you did not complete the
Filter by Selection previous task open the file

Datal Exl completed.xlsx

Click and select a cell in the Discount column which contains the
value of £0.00. Right click on this cell and select Filter | Filter
by Selected Cells Value

LIVUP UNGIoUp SubLULal
cut - -
Copy Outline

Paste Options:

FE

Paste Special...

B & e|

Insert..
Delete..
Clear Cantents
Filter
Sort

3 Insert Comment Filter by Selected Cell's Value

’_’r Format Cells... Filter by Selected Cell's Color
Pick From Drop-down List... Filter by Selected Cell's Eont Color
Define Name... Filter by Selected Cell's [con

@, Hyperlink...

=

Your results should look similar to below

A B C u] E F G H

1 | INVOICE MUMBEF - | DATE|~| FIRM CODI~| COMPANY NAME~ BUDGET CODI~| AMOUNT ~| DISCOUNT -T TOTAL ~
14 1247 12/08/2013 1 Euttons & Pins 440 £233 DDI £0 DD! £233.00
16 1249 16/01/2013 3 Hardcopy stores 440 £86.00 £0.00 £96.00
18 1251 20/01/2013 ] Fixit Ltd 444 £876.00 £0.00 £876.00
21 1254 26/01/2013 2 Comp. Stares 440 £348.00 £0.00 £348.00
27 1261 0e/02/2013 3 Hardeopy stores 448 £867.00 £0.00 £867.00
44 1278 27/08/2013 4 Fixit Lt 441 £947.00 £0.00 £847.00
53 1287 24/0452013 3 Plugs and Sockets 442 £622.00 £0.00 £622.00
71 1306 194072013 3 Fixit Ltcl 448 £498.00 £0.00 £498.00
75 1310 28/06/2013 3 Sitting Pretty 440 £785.00 £0.00 £785.00
77 1312 03/07/2013 3 Hardeopy stores 442 £372.00 £0.00 £372.00
79 1314 14012/2013 3 Plugs and Sockets 448 £896.00 £0.00 £896.00
84 1319 20012/2013 3 Hardcopy stores 440 £130.00 £0.00 £130.00
il 1321 30/07/2013 3 Plugs and Sockets 440 £646.00 £0.00 £646.00
94 1329 25/08/2013 B Sitting Pretty 440 £263.00 £0.00 £263.00
96 1331 29/05/2013 1 Euttons & Pins 440 £233.00 £0.00 £233.00
98 1333 03/09/2013 3 Sitting Pretty 440 £86.00 £0.00 £96.00
1a0 1335 08/05/2013 4 Fixit Ltd 444 £876.00 £0.00 £876.00
103 1338 10/05/2013 2 Comp. Stares 444 £4536.00 £0.00 £4.536.00
110 Total 18 £13.320.00 £0.00 £13.320.00

EEE}

Step 2
Clear the filter from the Discount field.

Either select (Select All) from the DISCOUNT column drop
down list or select Clear Filter From “DISCOUNT?” which
has a clear filter icon alongside.

The filter drop down arrows will remain on the column headings.
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Task 2 Step 1

Locate the 5 highest amounts of discount. | Click on the drop down arrow next to DISCOUNT and select
Number Filters | Top 10

F G H J
CoDI - AMOUNT |~ DISCOUNT (| TOTAL |~
&1 Sort smallest to Largest £2,384.69
%l sortLargest to Smallest £3032.22
Al satt arges 1o mates £3.123.40
Sort by Colar S £235711
£1.141.47
£4,034.65
| comarzn
Number Filters > Equals...
Search o Does Not Equal..
- Greater Than...

Greater Than Or Equal To...
Less Than...

Less Than Or Egual Ta...
Between..

Top10..

Above Average

Below Average

RN

Step 2

The Top 10 AutoFilter dialog will appear. Change the
number to 5 and click on

Top 10 AutoFilter -

Show

-] 5 B em []

’ aK ][ Cancel ]

b

Your results should look similar to below

A B [ (0] E F G H
1_ INVOICE HUMBEF ~ DATE | *| FIRM CODI*| COMPANY NAME * BUDGET CODI ~ AMOUNT |~ DISCOUNT |-T TOTAL
10 1243 17/09/2013 5 Perdectord 440 £4554.00 £227.70 £4.326.30
30 1264 12002013 1 Buttons & Pins 444 £4,934.00 £246.70 £4 687,30
[t 1293 07/06/2013 B Sitting Prathy 442 £4,739.00 £236.95 £4502.05
a0 1315 14122013 3 Plugs and Sockets 446 £4826.00 £246.30 £4679.70
108 1343 23002013 3 Flugs and Sockets 440 £4,933.00 £246 R 4 B8R.35
110 Tatal [ £24,086.00 £1.204.30 £22.881.70
111
Step 3

Remove the filters.

Click on Data | Sort & Filter | Clear to remove the filters.
The drop down filter arrows should still appear above each
column heading.

Save the file.
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Exercise 4 Filter by colour

. Apply an AutoFilter - See Section 3.4
. Filter by cell fill colour and text colours - See Section 3.4

Task 1 Step 1

Filter Budget Code 440 (coloured Open the file named Colour Filter.xIsx
orange) and amounts >1000 and Step o
<=2000 (coloured in pink) using the P . .

filter by colour option. From the Data | Sort & Filter menu select Filter.

Drop down arrows will now appear above each column heading

Step 3
Select the drop down arrow in the Budget Code column and
select Filter by Colour

Select the orange fill colour from the Filter by Cell Colour
drop down list

D E F
I~ COMPANY NAME - | BUDGET COD[~| AMOUN~| DIt
4] sort Smallest to Largest £3,077.00
%l sortlargest to Smallest £3,126.00
Sort by Color r £3,220.00
£2,3893.00
£115300
Filter by Color * | Fitter by Cell Color
Humber Eilters [
Search A | —
¥ (select Al)  —
-] 440
- 441 [
-] 442
m Filter by Font Color
|
|
|
|
[ ok ][ cancer | L
401200

Step 4

Select the drop down arrow in the Amount column and select
Filter by Colour

Select the pink Filter by Cell Colour from the drop down list

Your spreadsheet should look similar to below.

VOICE NUMBER ~| DATE|~| FIRM CODI~| COMPANY NAME ~| BUDGET COD|.T| AMOUN.T| DISCOUNT |~| TOTAL|~

1239 27/08/2013 2 Comp. Stares 440 £1.153.00 £1153 £1.141.47
1242 171124203 4 Fixit Ltd 440 £1.701.00 £17.01 £1.683 49
1248 14/01/2013 3 Hardcopy stores 440 £1.961.00 £19.67 £1.94139
1253 2840142013 1 Euttans & Pins 440 £1.401.00 £14.01 £1.386 99
127 24/08/2013 3 Hardcopy stores 440 £1.994.00 £19.94 £1.974.06
1274 02/03/2013 3 Hardcopy stores 440 £1.506.00 £15.08 £1.430 94
1286 21/04/2013 3 Hardcopy stores 440 £1,552.00 £16.62 £1.536.48
1297 16/08/2013 3 Comp. Stares 440 £1.479.00 £1479 £1.464.21
12493 1B/05/2013 3 Fixit Ltd 440 £1.692.00 £18492 £1.87308
1308 20/08/2013 3 Plugs and Sockets 440 £1.178.00 £11.78 £1.166.22
1303 25/06/2013 3 Plugs and Sockets 440 £1.218.00 £1218 £1.20552
1316 15/02/2013 5 Perfectvord 440 £1,369.00 £13.88 £1.375.11
1332 02/08/2013 3 Plugs and Sockets 440 £1.961.00 £1961 £1.94139
Total 13 20385 £203.85 £20,181.15

Task 2
Save and close your file
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Exercise 5 Using the Advanced Filter

e Set a criteria range - See Section 3.6.1
e Set a filter using multiple AND / OR criteria - See Section 3.6.2

Task 1

In this task you will locate records
with aBudget code of 444 OR fora
Budget code of 440 where the
Total is greater than 4000

Task 2
Enter the criteria to the range

Step 1
Work on the file Datal.x1sx which you previously saved in
Exercise 3 or if you did not complete Exercise 3 open the file

Datal Exl Completed.xlsx

Step 2

Set up a criteria range to use the Advanced Filter option

To create a criteria range insert rows above your data to allow for
the column headings two rows for your criteria for this example and
one blank row, so 4 rows in total.

Click and select the row numbers 1 to 4 so the row contents are
highlighted and then right click and select Insert. 4 rows will have
now been inserted.

Copy the column headings now located in row 5 to row 1. Your
spreadsheet will look similar to below.

A

INVOICE NUMBER

5

B 1236
7 1236
L) 1237
9 1236
1238
11 1240
1741

INVOICE NUMBER

B o] D E F G H

DATE FIRM CODE = COMPANY NAME  BUDGET CODE AMOUNT DISCOUNT TOTAL

DATE
16/07/2013
20/11/2013
2771172013
27/07/2013
27/06f2013
0471212013
11mA017

FIRM CODE  COMPANY NAME

Buttons & Pins

BUDGET CODE
440

AMOUNT
£3077.00

DISCOUNT
£82.31

TOTAL
£2.98468
440
440
440
440
440
aan

£3,126.00
£3,.22000
£2.39300
£1.163.00
£4247.00
7 RATAN

£9378
£96.60
£3590
£1153
£21235
£an o8

£303z.22
£3123.40
£2.357.11
14147

1

3 Plugs and Sockets
1 Butians & Pins

5 Petfactt/ord

2 Comp. Stores

1 Buttons & Pins

3 Darfarkiinrr

£4.03465
€9 Ra? 7R

Step 1

Enter criteria 440 immediately underneath the column
heading Budget Code within the criteria range, in the above
example this is cell F2.

Enter the criteria >4000 underneath the Total column
heading in the criteria range, ensure it is on the same row as
the Budget code 440 criteria.

Enter criteria 444 underneath the previously entered
criteria of 440 in the Budget code column.

The criteria will look as below

A B © D E F G H
1 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL
2 440 »4000
3 444
4
5 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL
11 1240 04/12/2013 1 Buttans & Fins 440 £4.247.00 £212.35 £4.034.65
14 1243 17/09/2013 5 PerfectWord 440 £4.,554.00 £227.70 £4.326.30
15 1244 24/10/2013 5 Perfectord 444 £4,351.00 £21755 £4.133.45
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Task 3
Run the Advanced Filter

IT Learning Programme

Step 1
Click within the data set, which is from row 6 onwards.

From the ribbon menu select Data | Sort&Filter | Advanced

wiew View Developer

AnREE g

Z| Sart | Filter
Al __‘!")Ad\tanced ¢

Sort & Filter

The Advanced Filter dialog box will appear.

4 |
Advanced Filter li‘éJ
Action
(@ Filter the list, in-place
(") Copy to another location
List range: SASD:EHE113
Criteria range:
Copy to: $1865 e
[7] unique records only
[ CK ] ’ Cancel
LS
Step 2

e Click on the collapse dialog box T to the right of the
Criteria range:

e Select cells A1:H3. Do not include the blank row as the
filter will not then work.

e Click on the collapse dialog box %] again to return to the
Advanced Filter dialog box.

The Advanced Filter dialog box should now show the criteria
range set as below

Step 3
r;\fld\ranced Filter l ? 2 1

Action
@ Filter the list, in-place
() Copy to another location

List range: §AS5:EHE113
Criteria range: | §A%1:6HE3|
Copy to: £15 B

[ Unigue records only
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e (Clickon to filter the data.

Your data will be similar to below.

A E c 5] E F G H

1 INVOICE NUMBER DATE FIRM CODE = COMPANY NAME = BUDGET CODE AMOUNT DISCOUNT TOTAL

2 440 >4000

3 444

El

5 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL

11 1240 04n12/2m3 1 Buttans & Pins 440 £4,247.00 £212.35 £4,03465
14 1243 17j09/2013 5 Perfectivord 440 £4,654.00 £227.70 £4.326.30
15 1244 2410/2013 5 Perfectord 444 £4,351.00 £217.55 £4.133.45
18 1245 25/12/2013 B Sitting Prethy 444 £3,127.00 £93.81 £3.03313
17 1248 27/06/2013 5 PerfectW/ord 444 £4513.00 £225 B £4.287.35
21 1250 20/01/2013 4 Fixit Ltc! 440 £4,27300 £213.65 £4.055.35
22 1251 20/01/203 4 Fixit Ltcd 444 £876.00 £0.00 £876.00
34 1264 12a0/2m3 1 Buttans & Pins 444 £4.93400 £246.70 £4.667.30
40 1270 23042ms3 2 Caomp. Stores 444 £3,660.00 £709.50 £3,54050
54 1284 1804203 4 Sitting Prethy 444 £2,193.00 £32.90 £2,160.11
93 1324 1oeszms3 3 Plugs and Sockets 444 £2.778.00 £41.67 £2,736.33
495 1326 22/06/2013 4 Fixit Ltc! 444 £1.062.00 £10.82 £1.071.18
94 1330 26/08/2013 B Sitting Prethy 444 £2,634.00 £39.51 £2,694.49
103 1334 04/08/2013 4 Sitting Prethy 440 £4,273.00 £213.65 £4,069.35
104 1338 0&/05/2013 4 Fixit Ltc! 444 £876.00 £0.00 £876.00
107 1338 10/05/2013 2 Comp. Stares 444 £4,536.00 £0.00 £4.536.00
112 1343 2310/2013 3 Plugs and Sockets 440 £4,933.00 £246 65 £4.656.35
114 Total 17 £57.830.00 £2132.11 £55.697 490
115
116

Task 4 Step 1

Remove the filter e Select Data | Clear to remove the filter from the
Sort&Filter category.

A Al Z \{:‘ Clear _
!!l 7| A { .

z ; .
ﬁl Sort Filter

‘{/" Advanced

Sort & Filter
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Exercise 6 Using Advanced Filter to extract a unique records list

e Create a list of unique records in the same worksheet - See Section 3.6.3
e Create a list of unique records on a different worksheet - See Section 3.6.4

Task 1 Step 1
Extract a unique list of Budget Codes | Continue to use your file Data1.xIsx or if you did not complete
to cell K1 the previous exercise then open the file Data1l Ex5

completed.xlsx

Click into the table/range of data and select Data | Sort and
Filter | Advanced filter.

The Advanced Filter dialog box will appear.
Advanced Filter (L S|

Action

Filter the list, in-place
@ Copy to another location

List range: SESSISES113 %
Criteria range: %
Copy to: gKE1 %

[ oK l | Cancel

You then have an option to Filter the list in-place or Copy to
another location. Select Copy to another location

The List range is the column of data you would like to locate a
unique set of records from. For this exercise it is the Budget
Codes which are in range E5:E113. Note that row 114 contains
totals and you do not want to include this row in your unique
value list. If you inadvertently select this and it is included in your
unique list then you can then delete it from there.

The Criteria range can be left blank.

In the Copy to text box click into cell K1 in your existing
worksheet and the cell reference will be inserted for you.

Add atick to the Unique records only check box and click the

button.

A unique list of Budget Codes will be placed into cell K1 as
below. If the number 108 is also included in this list then you also
included the total row in your selection. This can be deleted from
the list so it will then be the same as below.

K L

BUDGET
CODE

440
444
445

491
442
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Task 2 Step 1

Extract a unique list of Company Click into a new worksheet, cell A1, where you would like your list

Names to cell a new worksheet cell A1 to be placed. Select Data | Sort and Filter | Advanced
filter. The Advanced Filter dialog box will appear.

[ Advanced Filter )

Action

Eilter the list, in-place
@ Copy to another location

List range: ¥18045:505113 R
Criteria range: E
Copy to: Sheet1!5A51 E

[ oK ] | Cancel

(S

Select Copy to another location

The List range is the column of data you would like to locate a
unique set of records from. You will now need to click into the
Sales 2013 worksheet where your list is located and select cells
D5:D113 which hold the Company Names.

The Criteria range can be left blank.

Select the Copy to text box and the new worksheet you originally
selected will open. Click into cell A1 in this worksheet and the
worksheet and cell reference will be inserted for you.

Add a tick to the Unique records only check box and click the

button

A unique list of Company Names will be placed into worksheet
Sheetl, cell A1 as below. Rename the worksheet Data Lists

A B

COMPANY |
NAME 1

Buttons & Pins
Flugs and Sockets
Perfectiiord
Comp. Stores
Fixt Lt

Sitting Pretly
Hardcopy stores

oo o =

Step 2

Now move the unique list of Budget Codes from the worksheet
Sales 2013 cells K1 to K6 to the newly named Data Lists
worksheet starting in cell C1

Task 3
Save your file
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Exercise7 Subtotalling data in a range

e Sort the data - See Section 4.1.1

e Sum the Amount sold for each Company - See Section 4.1.2

e Count the Budget Code field within each Company - See Section 4.1.3

Task 1

Produce subtotals to show how much each
Company has purchased before discount
and count each Budget Code purchased by
each Company

Task 2

Sort the data by Company and then by
Budget Code

Step 1

Work on the file you previously saved, having completed
Exercise 6 (Datal.x1lsx) or if you did not complete Exercise
6 open the file

Datal Ex6 Completed.xlsx

Step 1

As you are now inserting subtotals remove the previously
inserted totals from row 114

Sort the range by Company Name and then by Budget
Code.

Click in the range of data and select Data | Sort and Filter

| Sart

and the Sort dialog box will appear.

Select Company Name from the Sort by list and the
Order can be left as AtoZ. Select Add Level.

In the Then by box select Budget Code from the drop
down list and the Order can be left as Smallest to Largest

Your Sort dialog will look like below

Select
-
Sort A
“s]Add Level || X Delete Level || i3 Copy Level ‘“ - Options... V] My data has headers
Column Sort On Order
Sortby |COMPANYNAME  [v] |Values [»] AtoZ v
Thenby  BUDGET CODE ilw] |values [w] smallest to Largest =
|
|
|
| [ ok Cancel
Task 3 Step 1

Insert subtotals to show the total Amount
sold per Company before discount.

IT Learning Programme

Click into your data range then select Data | Outline |
Subtotal on the ribbon.

= = =
vgJ «gi ?J #Z Show Detall
te g & =Z Hide Detail

Group Ungroup Subtotal

Qutline

The Subtotal dialog box will now appear.
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Step 2

The At each change in: the box will automatically display
the label of the leftmost column.

Click the drop-down arrow and select Company Name

Step 3

The Use function: box displays the summary function to be
used. Ensure the Sum function is selected. To change the
function you can click on the drop down arrow and select a
function.

Step 4
The Add subtotal to: box displays the label of the

rightmost column or the label of the column last selected.
Labels that are checked in this box will be subtotalled.

Deselect Total by clicking in the check box beside it and
removing the tick. Add a tick beside the Amount check box.
Make sure no other column labels are checked.

Step 5
Indicate the position of the summary totals by clicking the
Summary below data box. The subtotals will appear
above the data values unless this box is checked.

Note: The Replace current subtotals checkbox should
be checked at this point to ensure any previous subtotals are
overwritten.

("subtotal =D [ |
At each change in:
COMPANY NAME [~]
Use function:
Sum IZ|
Add subtotal to:
FIRM CODE -

COMPANY NAME

BUDGET CODE

DISCOUNT

TOTAL o

[EE<IEIEL

Replace current subtotals
[ Page break between groups
Summary below data

I Remove All I [ oK ] I Cancel I

Step 6

Select for the range to be subtotalled.

Your spreadsheet will look similar to below
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A E A B C n] E F G H
4
5 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL
[ 1235 18/07/2013 1 Butions & Pins 440 £3,077.00 £92.31 £2.984.69
7 1237 27112013 1 Butions & Pins 440 £3,220.00 £96.60 £3.723.40
8 1240 0412/2013 1 Butions & Pins 1] 440 £4,247.00 £212.35 £4.034.65
] 1247 12/08/2013 1 Butions & Pins 440 £233.00 £0.00 £233.00
0 1253 26/01/2013 1 Buttons & Ping 440 £1,401.00 £14.01 £1.386.99
11 1331 29/05/2013 1 Buttons & Ping 440 £233.00 £0.00 £233.00
12 1337 17/06/2013 1 Buttons & Ping 440 £372.00 £14.01 £367.99
13 1262 09/09/2013 1 Buttons & Ping 441 £1,970.00 £19.70 £1.950.30
14 1263 11/02/2013 1 Buttons & Ping 442 £3,327.00 £99.81 £3.207.19
15 1264 12/110/2013 1 Buttons & Ping 444 £4934.00 £246.70 £4.687.30
16 1265 13/03/2013 1 Buttons & Ping 448 £2 E80.00 £40.20 £2.639.80
17 1266 14/04/2013 1 Buttons & Ping 448 £4110.00 £205.50 £3.904.50
- |18 1267 19/04/2013 1 Buttans & Ping 448 £2,089.00 £30.89 £2,028.12

- 149 Buttons & Pins Total £31.863.00

[ - |20 1238 27/06/2013 2 Comp. Stares 440 £1,153.00 £11.53 £1,141.47
21 1284 26/01/2013 2 Comp. Stares 440 £348.00 £0.00 £348.00
2z 1296 16/07/2013 3 Comp. Stares 440 £2,490.00 £37.35 £2,452.65
23 1297 16/08/2013 3 Comp. Stares 440 £1,479.00 £14.79 £1.464.21
24 1300 27/09/2013 3 Comp. Stares 440 £2,560.00 £38.70 £2,541.30
25 1301 2711002013 3 Cormp. Stares 440 £2,764.00 £41.76 £2,742.24
26 1268 19/02/2013 2 Cormp. Stares 441 £4118.00 £205.90 £3.912.10
27 1269 19/03/2013 2 Cormp. Stares 44z £1,409.00 £14.09 £1,394.91
28 1303 26/11/2013 3 Cormp. Stares 44z £2,574.00 £38.61 £2,535.39
29 1270 23/04/2013 2 Cormp. Stares 444 £3660.00 £109.50 £3,540.50

- | a0 1338 10/05/2013 2 Cormp. Stares 444 £4536.00 £0.00 £4,536.00
- kil Comp. Stores Total £27.121.00

Task 4 Step 1
Re subtotal the range to Count each Budget | Click into your data range then select Data | Outline |

Code purchased per Company. Your Subtotal on the ribbon.
previous subtotals need to remain. TR R

Group Ungroup Subtotal

Qutline

The Subtotal dialog box will now appear.

Step 2

At each change in click the drop-down arrow and select
Budget Code

Step 3

In the Use function box ensure the Count function is
selected. To change the function click on the drop down
arrow and select a function.

Step 4

In the Add subtotal to box deselect Amount by clicking in
the check box beside it and removing the tick. Add a tick
beside the Budget Code check box. Make sure no other
column labels are checked.

Step 5

Indicate the position of the summary totals by clicking the
Summary below data box. The subtotals will appear
above the data values unless this box is checked.

Note: This time the Replace current subtotals
checkbox should be unchecked to ensure any previous
subtotals are not overwritten.
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-

Subtotal

(B |

BUDGET CODE
Use function:
Count

Add subtotal to:

At each change in:

B[]

["] FIRM CODE

[C] COMPANY NAME

Replace current subtotals
[7] Page break between groups
summary below data

| Remove sl | |

oK

Your spreadsheet will look similar to below.

1)z]3]4 A B C D E F G H
4
5 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL
[[r- & 1235 18/07/2013 1 Euttons & Pins 440 £3.077.00 £92.31 £2,934.68
o |7 1237 271142013 1 Euttons & Pins 440 £3.220.00 £96.60 £3123.40
o E 1240 0411242013 1 Butions & Pins | 440 £4.247.00 £212.35 £4034.65
o [ & 1247 12/08/2013 1 Euttons & Pins 440 £233.00 £0.00 £233.00
- |10 1283 26/01/2013 1 Euttons & Pins 440 £1.401.00 £14M £1.386.98
S K 1331 29/05/2013 1 Buttons & Pins 440 £233.00 £0.00 £233.00
- [ 12 1337 17/06/2013 1 Buttons & Pins 440 £372.00 £14.01 £367.99
13 440 Count 7
lJ:'_l- 14 1262 09/09/2013 1 EButtons & Pins 441 £1.870.00 £19.70 £1.950.30
15 441 Count 1
lJ:'_l- 16 1263 1170242013 1 EButtons & Pins 442 £3.327.00 £99.61 £3,227.18
17 442 Count 1
lJ:'_l- 18 1264 1211042013 1 EButtons & Pins 444 £4.834.00 £246.70 £4667.30
19 444 Count 1
- | en 1265 13/03/2013 1 EButtons & Pins 446 £2.660.00 £40.20 £2639.50
-2 1266 14/04/2013 1 EButtons & Pins 446 £4.110.00 £205.50 £3,904.50
- |22 1267 19/04/2013 1 EButtons & Pins 446 £2.059.00 £30.69 £enzeie
23 446 Count 3
=] 24 Buttons & Pins Total £31.663.00
- [ 25 1239 27/06/2013 2 Comp. Stares 440 £1.153.00 £11563 £1.141.47
- | 26 1254 26/01/2013 2 440 £345.00 £0.00 £348.00

Comp. Stores

Step 7

Save your file
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Exercise 8 Hiding and showing subtotal detail

e Use the Row level buttons - See Section 4.1.5
e Use the Show and Hide detail boxes - See Section 4.1.5
e Remove Subtotals - See Section 4.1.4

Task 1 Step 1
This task is to use the row level view and the | Work on the file you previously saved, having completed
show and hide buttons to view your data Exercise 7 (Datal . x1sx) or if you did not complete Exercise
7 open the file

Datal Ex7 Completed.xlsx

Step 1

Using the row level view buttons view the different views of
your subtotals.

Also with view 4 selected and all data visible use the show and
hide buttons to view different sections of data differently.

Row level view buttons

Show detail box *I
1l2]3]4 A B C D E F G H |
4
5 INVOICE NUMBER DATE FIRM CODE COMPANY NAME BUDGET CODE AMOUNT DISCOUNT TOTAL
[+ 13 440 Count 7
[-]14 1262 08/08/2013 1 Buttons & Fins 441 £1.8970.00 £19.70 £1.950.30
- 15 1 441 Count 1
r - | 16 1263 11/02/2013 1 Buttons & Pins 442 £3.327.00 £99.81 £3.227.19
- 17 442 Count 1
r - | 18 1264 12/10/2013 1 Buttons & Pins 444 £4.934.00 £246.70 £4.667.30
- 19 444 Count 1
[ -] z20 1285 13/03/2013 1 Euttons & Fins 448 £2.680.00 £40.20 £2.639.80
21 1266 14/04/2013 1 Buttons & Pins 446 £4.110.00 £205.50 £3.904.50
|22 1267 19/04/2013 1 Buttons & Pins 446 £2.059.00 £30.89 £2.028.12
= 23 446 Count 3
- 24 Buttons & Pins Total £31.863.00
[[: 25 1238 27/06/2013 2 Comp. Stores 440 £1.153.00 £11.63 £1.141.47
26 1254 26/01,/2013 2 Comp. Stares 440 £348.00 £0.00 £348.00
27 1256 16/07/2013 3 Comp. Stares 440 £2.490.00 £37.35 £2.452.65
28 1297 16/08/2013 3 Comp. Stores 440 £1.479.00 £14.79 £1.464.21
29 1300 27/09/2013 3 Comp. Stares 440 £2.,550.00 £38.70 £2,541.30
30 13m 27/10/203 3 Comp. Stares 440 £2.784.00 £41.78 £2.742.24
—_ el AAN Crunt [
Hide detail box
Step 2

Remove all subtotals before saving your file.

To remove subtotals choose Data | Subtotal from the
Outline category and click on Remove All to remove your
subtotals.

Save your file
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Exercise 9 Consolidate data

e Insert a table - See Section 2.2.3
e Create subtotals using Data Consolidation - See Section 4.2

Task 1 Step 2
This task is to create a summary of Work on the file you previously saved, having completed Exercise 8
data for a total of the Amount, (Datal.x1lsx) or if you did not complete Exercise 8 open the file

Discount and Total and also count | pata1l Ex8 Completed.xlsx
the number of sales per Company
Step 1
Ensure the subtotals have been removed from your data, if not please
see, Exercise 8Task 1Step 2.

Task 2 Step 1

Remove the criteria rows and First remove the criteria range rows from your data. Select rows 1 to
convert your range to a table and 4, right click and select Delete

name it Sales2013 e e B

INVOICE NUMBE| B | 7 [ =& - A - 55 - 58 % F NY A

-

ra

= % cut
——Ea Copy

s

PasteOptions: | copE  COMPANY N

Buttons & F

5 INVOICE NUMBE -
5 1238 =
7 1237 Buttons & F
8 Buttons & F
g9 Buttons & F
Buttons & F
Buttons & F
Buttons & F
Buttons & F
Buttons & F
Buttons & F
Buttons & F
Buttons & F

Paste Special.

1240
1247 Insert

10 1263 Delete

11 1331 o

12 1337

13 1262 & Eormat Cells...

14 1263 Bow Height...

16 1264

16 1285 Hiae

17 1266 Unhide

Step 2
Click into your data and create a table named Sales2013

Clear Contents

Click on Insert | Table the following range should be in the text
box

Create Table I. ? &J

Where is the data for your table?

)

ﬁ"i

| My table has headers

[ Ok ] | Cancel |

L

Click on
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Task 2

Use Data Consolidation to
summarise your data to display a
total of Amount, Discount and
Total and also count the number of
sales per Company

IT Learning Programme

Step 3
The Table Tools | Design ribbon will now be available. Select
Properties and insert Sales2013 for the name of the table
I;_Tll =

Table Name:
Sales2013
I Resize Table

Properties

Step 1

With Data Consolidation you do not need to pre-sort your data. To
show the consolidation totals working, unsort your Company name
field by sorting a different field.

Sort your data by Invoice number. Click into the Invoice
A
number column and click on the Data | 2 button

Step 2

Open a new worksheet and click into cell A1 where we would like the
summary to appear.

Click on Data | Data Tools | Consolidate

== = = L e

i g-.-—' —5 J-MEI ﬁ'g}?

ek — X iy

Textto  Remove Data Consolidate What-If

Columns Duplicates Validation = Analysis =
Data Tools

The Consolidate dialog box will the display
9 [ |

Consolidate

Function:
Sum

[]

Reference:

Browse...

Add

All references:

-

-
Use labels in

[ Top row

[ Leftcolumn  [] Create links to source data

Step 3

In the Function drop down list, the default is Sum and this is the
function we need, leave this selected.
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Step 4

Click into the Reference text box and select a range to consolidate.
The left most column of data will be the field which you are
summarising, so Company Name is required here and the right
most column will be the final field which contains the data you would
like to summarise, which will be Total

Step 5

Check the two check boxes Top row and Left column and click on
Your data will summarise similar to the example below.

A, B T D E
1 BUDGET CODE AMOUNT DISCOUNT TOTAL
2 Buttons & Pins 5745 £31.863.00 £1.072.08 £30.790.93
3 |Plugs and Sockets 7082 £36,871.00  £1,017.48 £35853.62
4 Perectord 4427 £27.892.00  £1.006.92 £26.885.09
5 Comp. Stores 4853 £27.121.00 £612.23 £26.608.77
£ Fixit Ltd 8859 £52,492.00  £1,626.93 £50,665.08
7 Sitting Pretty 7077 £41.014.00 £1,504.15 £39.509.86
8 Hardcopy stares 9720 E5Z.885.00  E1.B49.2F £51.235.78
3

Step 6

You will see that it has summarised all fields which were selected, one
of which you is not required. Delete the Budget Code field which is
not needed.

Select Column B, right click and select Delete
Step 7
Rename Sheet2 as Sales Summary 2013

Point at the worksheet tab named Sheet2 and double click. Insert a
new worksheet named Sales Summary 2013 and press
<RETURN>

Rename Sheet1 as Master Lists
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Task 3

Insert an additional total to count
the number of sales per Company

Step 1
Select a cell next to your current summary on the newly named
Sales Summary 2013 worksheet, cell E1, and repeat the process,
this time selecting Count from the Function menu.

This time you will not need to reselect the range for the Reference
text box, you can click on the previously inserted reference located in
the All references box

7 ~
Consalidate l ? J—Jﬂh
Function:
Count IZ|
Reference:
'Sales 201315D$1:5H§103
All references:
'Sales 201318D81: 8H$109 P
:
Use labels in
Top row
Left column [ create links to source data

[ o

| {

Close ]

%

Once again a surplus number of columns, counting your data will
appear. Delete columns E, G, H, & I which are not required.

Give the newly counted data in column E a new field name of Number
of Sales

Your summary should look similar to below.

IT Learning Programme

&, B > D E F

MNurnber of

1 AMOUNT  DISCOUNT TOTAL  sales

2 Buttons & Pins £31.863.00  £1.072.08 £30.790.93 13

3 Comp. Stores £15,214.00 £341.02 £14.872.98 E

4 Fixit Ltd £52.492.00  £1.626.93 £50.665.08 20

5 Hardcopy stores £101,663.00 £2,837.91 £95.525.09 43

b PerfectMord £27.892.00 £1.006.92 £26.685.09 10

7 Sitting Prety £41,014.00  £1.50415 £39.509.56 16

8

Step 2

Save and close your file.
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Exercise 10 Creating charts

o Create a 2D column chart - See Section 5.2

. Create some other chart types - See Section 5.2

o Create a chart on a separate sheet - See Section 5.2
Task 1

Open the file called charts .xIsx
This workbook contains test score figures for four different regions

Data for each region is on a separate worksheet

Task 2 Step 1
Create a 2D column chart with the data for Select the Scotland worksheet and select the data that is
Scotland to be plotted (A3:E7)

Include the column and row labels (row 3 and column A) in
the selection, so these will appear on the chart

Step 2

On the Insert tab, choose Column from the Charts group

Choose the first type which is the 2-D Column

Step 3

A new chart is inserted on this worksheet, floating over the
cells

Step 4

If the position of the chart is not convenient, drag the thick
border of the chart to move it to a better position

Task 3 Step 1
Create embedded charts for the other Create a 3D column chart for England, embedded on the
regional sheets England sheet

Step 2

Repeat for Wales and N_lIreland
Experiment with other chart types if you like

Task 4 Step 1

Create a chart for the Summary data, on a Switch to the Summary sheet

separate chart sheet Select the data cells, including the labels: A3:E7
Step 2
Press the key F11
Step 3

A new chart, with all the default settings, is created on a
separate sheet

Step 4
Rename the chart sheet Summary Chart
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Exercise 11 Rearranging the chart

o Mouve the chart location - See Section 5.5

. Experiment with viewing data as different types of chart - See Section 5.5

o Switch data between rows and columns - See Section 5.5

o Change the colour scheme - See Section 5.5
Task 1

Continue work in charts.xIsx

Task 2 Step 1

Move the chart between worksheets

Task 3

Experiment with viewing data as
different types of chart

Finish with a 2D column chart

Task 4

Switch the data series between rows and
columns

Task 5
Try some different colour schemes

IT Learning Programme

Select the embedded chart on the Scotland worksheet: you
may need to click on it to activate it (thick border appears
around the chart)

Step 2

]
Click we= (probably found at the right-hand end of the Chart

Design tab of the ribbon)

Step 3
Select As new sheet: and use the name Scotland_Chart

Step 1
Make sure the sheet Scotland_Chart is active

Step 2
Click on the Design tab of the ribbon

Step 3

Click on the Change Chart Type button C;E:'fj to change the
chart type

Step 4
Try out some different chart types (e.g. bar, 3D column)

Step 5
When finished, please change back to a 2D column chart

Step 1

You can switch the chart so that the Weeks 1 to 4 are shown
along the horizontal axis, and the months are the column

-

colours using _ sw

Row/Column

Step 2

Switch again, finishing with an arrangement that you feel
makes sense of the data

Step 1

With the same chart active, choose a different colour scheme
from the Chart Styles on the Design Chart tab of the
ribbon
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Step 2

For each colour scheme, there are several style variations
available if you click =

Step 3

Bear in mind that if you will be printing using black ink only, a
black & grey colour scheme will probably give best results

Exercise 12 Selecting and resizing chart objects

The parts of a chart - See Section 6.1

Select parts of the chart using the mouse and the ribbon - See Section 6.1
Select a data series or point - See Section 6.1

Move, resize or delete a chart object - See Section 6.1

Task 1
Continue work in charts .xIsx or open charts partial1.xIsx
Task 2 Step 1
Practice using the mouse to select parts | Click on the Scotland chart
of the chart
Step 2

Practice using the mouse to select parts of the chart: axes,
gridlines, or titles

Step 3
Pause the mouse over a part, to see its name as a ScreenTip

Step 4

Click once to select a data series — notice the coloured handles
that appear on some or all of the data points in the series

Step 5

Click a second time on one data point — notice the coloured
handles that appear on just that data point

Task 3 Step 1
Select parts of the chart using the drop- Notice that the object currently selected is indicated in the
down control control at the left of the Chart Layout tab and the Chart
Format tab
Plot Area -
Step 2
Practice selecting parts of the chart using this control
Task 4 Step 1
Right-click parts of the chart to see Right-click on the Plot Area

commands available

Notice the commands available on the context menu

Step 2

Right-click on some other parts of the chart, and notice the
different commands that are offered
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Task 5
Practice resizing chart objects

Task 6
Practice moving chart objects

Task 77
Delete an object

Exercise 13 Formatting the chart

Step 1

Use any of the above methods to select the Legend

Step 2

Position the mouse pointer over any one of the object handles
The pointer shape changes to a two-way arrow

Step 3

Click and drag with the mouse to stretch the legend

Step 1

Select the legend and then position the mouse pointer over its
border (not a handle)

The pointer must be a four-way arrow to move the object

Step 2

Click and drag the legend to a new position, such as the top
centre of the chart

Step 1
Delete the chart title and the horizontal axis title, if they exist

o Format your chart to suit your requirements - See Section 7.1

. Borders and shading - See Section 7.1
o Font formatting - See Section 7.1

. Shape and style - See Section 7.1

Task 1

Continue work in charts.xIsx or open charts partial1.xIsx, on the Scotland sheet

Task 2

Give the chart area a coloured shading
and a border
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Step 1

Move the mouse around the chart until the ScreenTip says
Chart Area

Step 2

Click once to select the chart area

Click \'20._, Format Selection On the Chart Layout or Chart
Format tab of the ribbon

Step 3

From the panel on the left of the dialog, choose Border Color
Change the colour to a Solid line (red)

Step 4

Choose the Fill category

Set a pale coloured solid fill
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Step 5
Investigate the other categories from the left panel

Click

Task 3 Step 1

Change the font settings (typeface, font Click once in the Chart Area

size and colours) of the whole chart Step 2

Notice that you can also change the font type, size, etc. from
the familiar formatting buttons on the Home tab

Make a few improvements

Task 4 Step 1

Reformat the legend to make it clear and

. . If necessary, show a legend using L:Jd on the Chart Layout
Interesting :

tab
Select the legend

Step 2
Click % Format Selection ON the Chart Format tab of the
ribbon

Step 3

Using the Legend Options tab, change the Legend
Position toTop

Choose when finished

This is an alternative to dragging the legend

Task 5 Step 1

Apply a different shape style to one of the | Click once on one of the data series (i.e. one of the columns in
series of data columns or to one your chart)

individual data point Notice that the object handles indicate the series you are
working with

Step 2
Choose one of the Shape Styles from the Format tab

Step 3
Click again on one data point (ie. one column of the series)

Notice that the object handles now indicate just this single data
point

Step 4
Apply a contrasting Shape Style to this data bar

Choose when finished
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Exercise 14 Making a chart more readable

. Control the way the vertical axis displays - See Section 8.1
o Give a title to the whole chart - See Section 8.1

o Label the axes - See Section 8.1

Task 1

Continue work in charts.xIsx or open charts partial2.xIsx, on the Scotland chart sheet

Task 2

Change the formats and appearance of
the vertical axis

Task 3

Change the vertical axis to plot between o
and 500

Task 4
Insert a chart title

IT Learning Programme

Step 1

Move the mouse pointer carefully until the screentip says
Vertical (Value) Axis

Note it may be easier to point to an axis number than the
vertical line which is rather thin

Right-click on the Value Axis (Y or vertical) and choose
Format Axis
Step 2

If this is difficult, use the drop-down control at the left end of
the Chart Layout tab, and choose Vertical (Value) Axis

then click Qg.,- Format Selection

Step 3
Choose the Number category in the left panel

Specify Number formatting with o decimal places

Step 1

Still in the Format Axis dialog, display the Axis Options
category

Step 2
Change the Maximum to Fixed and 500

Step 3
Investigate the other categories from the left panel

Choose when finished, and examine the effects on
your chart

Step 1
Select the England sheet, which has a chart embedded on it
Make the chart active (click once to see the thick border)

Step 2

Choose Layout tab of the ribbon, and from the Chart Title
choose Above Chart

A new textbox appears above the plot area
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Task 5

Insert titles for the horizontal and
vertical axes

Task 6
Edit the text of a title

TMSE3 Organising and Displaying Data

Step 3
Edit the text in the Chart title textbox to England results

Step 4
You can adjust the formatting of the chart title using the

Home tab formatting buttons

Step 5
You can also move the textbox anywhere on the chart

Step 1

fhas]
On the Chart Layout tab, click 4=

Titles ~

Step 2

Now choose Primary Horizontal Axis Title| Title Below
Axis

Step 3

Change the text to Months tested

When you have finished typing in the text box, do not press
ENTER (that would give you a new line), so press ESC or click
on some other part of the chart

Step 4

Repeat to insert exam scores as a rotated title beside the
vertical axis

Step 1
Select the title that you wish to edit by clicking on it once

Blue object handles around the title indicate that it has been
selected

Step 2

Position the pointer over the text of the selected title
You should notice that the pointer changes to an I-beam
Click in the title

Step 3

A cursor (like that used in word-processing) appears within the
text

Edit the text by deleting or inserting characters as you would
with a word-processor

Step 4
When you have finished, click away from the object

This de-selects the edited title, leaving the changes intact
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Exercise 15 More chart options

. Set up data labels on a whole chart - See Section 8.1

o Show data labels on one series - See Section 8.1

. Show data labels on one data point - See Section 8.1

. Explore some of the options available from the Layout tab - See Section 8.1

. Legend - See Section 8.1
o Gridlines - See Section 8.1
o Data table - See Section 8.1

Task 1

Continue work in charts.xIsx or open charts partial3.xIsx, on the Scotland chart sheet

Task 2
Set up data labels on all series in a chart

Task 3
Delete the data labels

Task 4

Set up different kinds of labels on each
series in a chart

Task 5
Add a data label on one point only
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Step 1
Choose Layout Chart Tools tab of the ribbon and choose
[

Data
Labels ~

Step 2

With no data series selected, select one of the Data labels
positions (Center, Inside End, Inside Base, Outside
End)

Step 3

Alternatively, click on More Data Label Options to
further change the labels

Step 1

To remove the data labels, repeat the above step but now
choose None from Data Labels

You can also remove one by clicking on it and pressing DELETE

Step 1
This time, select just one data series

Object handles will appear indicating that the whole data series
has been selected

™

Use o= to add labels to this series — choose to position the

value labels at the centre
Step 2
i

Select a different data series and click =, then choose a
different label position

Step 3

To change the formatting of existing data labels, use the same
button

Step 1

Select the data series, then single-click on one data point
(choose one whose value looks particularly high or low)
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Task 6

Explore some of the options available
from the Layout tab

Task 7
Add a legend

Task 8
Add a data table below the chart

Task 9
Review the finished chart:

TMSE3 Organising and Displaying Data

Step 2
The object handles should show on only one data point

Step 3

[ini
Use o= to add alabel to this point

els ~

(This feature is only available for some chart types such as
column charts)

Step 1

Choose the Layout tab of the ribbon

Step 2

ilns

Explore the effect of gridlines and their options using s

Step 3

Think about whether horizontal or vertical gridlines (or both)
would make your chart easier to understand

Step 1

il
On the Layout tab of the ribbon, click tesee

Step 2
Try some of the options for the position of the legend

Step 3
Finish with it Shown at the Right

Step 1

ﬂ
On the Layout tab of the ribbon, click =

a
ble -

Step 2
Insert a data table below the chart

Step 3

Try the options: do you think that showing the legend key
helps, or not?

Is it easy for your readers to understand what the data is saying?

Is the information clear or cluttered?

Make some final changes as needed

Task 10

Close the charts workbook, saving if you wish
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Exercise 16 Plotting non-adjacent ranges

. Create a chart using two non-adjacent data ranges - See Section 8.1

. Plot the average data contained in the England worksheet - See Section 8.1
o Label the chart - See Section 7.1

. Use formats to make the chart simple to understand - See Section 7.1

Your task is to plot the average test scores for England, without the separate month data. This means
that you have to plot data drawn from two separate worksheets into the same chart.

Task 1
Open the workbook regional scores .xIsx

Task 2 Step 1
Create a chart showing the scores in Select the range A3:A7 in the England worksheet

England for each of the location points 1

Hold the CTRL key and select the range G3:G7
to 4, averaged across the months

Step 2
Choose Insert tab of the ribbon and choose Column chart
(2D Column)

An embedded column chart will be inserted on the sheet,
showing only the average series of data

Task 3 Step 1

Confirm the data source/s used in the =

chart To check the range, click == on the Design tab
Step 2

The Select Data Source dialog will appear

Make sure that the Chart data range is
=England!$A$3:$A%$7, England!$G$3:$G$7

Step 3
the dialog without making changes

Task 4 Step 1
Format parts of the chart and add labels, @ Change the chart options and label the chart.

to make it easy to understand The chart title is Average Test Scores

Step 2
The horizontal axis title is Location

The vertical axis titleis Scores

Step 3

Although the legend is not needed yet, leave it in place as it will
be useful when more data series are added

Task 5
Move the chart to a separate chart sheet and name it BritishScores
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Exercise 17 Adding more non-adjacent ranges

. Add data from the Scotland and Wales worksheets using the Select Data dialog- See Section

8.2

. Add data from the N_Ireland worksheet using Copy & Paste - See Section 8.2

. Update the legend - See Section 8.2

Your task is to plot the average test scores for England, Scotland, N Ireland and Wales. This means
that you have to plot data drawn from three separate worksheets into the same chart.

You will now add in the data from the other regions.

Task 1
Continue work in regional scores .xIsx

Task 2

Add the corresponding data from the
Scotland worksheet to the
BritishScores chart

Task 3

Step 1
B
With BritishScores active, click s on the Design tab

Step 2

Click | 2499 t add another data series

Step 3

Collapse the Series name box using @

Click on the Scotland worksheet tab and then click on cell A1
Un-collapse the box

Step 4

Delete whatever is given in the Series values box then click
the collapse dialog button [Es]

Then click the Scotland worksheet tab and choose the range
G4:G7

Un-collapse the box
Step 5
Return to the Data Source dialog and click

Confirm that the Scotland average data has been added to the
chart

Repeat the above steps to add in the average figures from the Wales sheet
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Task 4

Use the Copy and Paste method to add in
the average figures from the N_lIreland
sheet

Task 5
Correct the legend text

IT Learning Programme

Step 1
In the N_Ireland worksheet, select G3:G7

Step 2
Copy

Step 3
In the new BritishScores chart, Paste

Step 4

The N Ireland data now appears as a 4th series in the summary
chart

Step 1

Notice that some of the entries in the legend are wrong — for
each series the series name should be taken from cell A1 of the
worksheet, because that is where the country names are
entered

Step 2

—
S

Choose Select Data Sekc

Step 3

In the Select Data Source dialog, choose the data series
currently called Average (which was taken from the England
worksheet)

Click the button

Step 4

In the Series name: text field change the entry to
=England!$A$1

Repeat for any other legend entries that are wrong

Step 5
Click [OK] to close the Select Data Source dialog
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Task 6

The column chart should now show data from Scotland, England, Wales, and Northern Ireland,
similar to Figure 1.

Average Test Scores

mEngland

cores

mScotland
mWales

mN Ireland

Point 1 Point 2 Point 3 Point 4

Location

Figure 1 Average Test Scores Column Chart
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Exercise 18 A chart with mixed types

. Plot all the test score figures for Wales in one combination chart - See Section 8.6
. Include the average data - See Section 8.6

. Show the average data as an area behind the monthly columns - See Section 8.6
. Label and format the chart - See Section 8.6

Figure 2 is a combination chart, where the monthly scores for the four location points are shown as
ordinary columns, however the average is shown as the shaded area behind.

You will create a similar chart.

Wales Test Scores

900 |

mPoint 1
= Point 2
= Point 3
mPoint 4

Figure 2 A combination chart

Task 1

Continue work in regional scores .xIsx or open regional scores partial1.xlsx on the Wales
worksheet

Task 2 Step 1
Create a new chart with the scores by Create a new 3D column chart for the range A3:E7

month and by point for Wales, including

the average figure for each month Step 2

Ensure that the months are shown along the horizontal axis
(you might need to switch the rows and columns by selecting

the chart and clicking Switch Row/Column on the Design
tab)

Step 3

Use the Copy/Paste method to add another data series showing
the average figure for each month (row A9:E9 on the
worksheet)

Step 4

Check that there is a legend listing the 4 Points and the
Average

Step 5
The Chart Title is Wales Test Scores

Step 6
The horizontal axis title is Month
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Task 3

TMSE3 Organising and Displaying Data

Step 7
The vertical axis title is Scores

Step 8

Move the chart as a new sheet and call it
Wales Results Chart

Step o9

You should now have a chart which illustrates the data from
January to April, at Points 1 to 4 plus the Average test score
totals

The objective now is to differentiate the Average figures from the Point 1 to 4 figures so that it can be

seen more clearly.

Task 4
Make the Average data stand out by

having a different chart type — an area
chart

Step 1
Select the Average data series (check that there are several
blue handles on columns of this series)

Step 2

i
Choose  chenge

Chart Type

Select a simple Area from the Chart Type list

Step 3

Use the buttons on the Chart Format tab to improve the
shading colours and fills if you like
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Exercise 19 A combination chart with a secondary axis

° Add a data series with the Total data - See Section 8.7

. Present the Total data against a secondary axis - See Section 8.7

. Set a more suitable axis scale for the secondary axis - See Section 8.7

. Label and format the chart, making the secondary axis distinct - See Section 8.7

Figure 3 is a combination chart, where the monthly scores for the four location points are shown as
ordinary columns, however the average is shown as the shaded area behind.

The total scores, whose values are of course much higher than the individual points, are plotted
against a secondary axis on the right, and the data series is shown as a line chart to distinguish it
from the columns.

You will create a similar chart.

Wales Test Scores

Meonth

Figure 3 A combination chart

Task 1

Continue work in regional scores .xIsx or open regional scores partial1.xlsx on the Wales
worksheet and the Wales_Results_Chart

Task 2 Step 1
Add a series with the total figures from In the Wales worksheet, select cells B8:E8

Wales (cells B8:ES8) to the chart Step 2

Copy

Step 3
In the Wales_Results_Chart, Paste

The Total data should appear as another data series, initially as
tall columns
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Task 3
Correct the legend text

Task 4

Display the Total series as a line on the
chart, to distinguish it from the monthly
columns

Task 5

Plot the Total data series against a
secondary vertical axis

Task 6
Set a suitable axis scale for the Total data

TMSE3 Organising and Displaying Data

Step 4

Notice that the vertical axis automatically re-scales, so as to
display the Total data which of course has bigger values than
the separate points

The monthly columns are temporarily rather small, but that
will improve shortly

Step 1

See Exercise 17 above for the steps to correct the text in the
legend from “Series 6” to “Total”

Step 1

Select the Total data series in the chart

Step 2

ud
Click e on the Chart Design tab of the ribbon

Step 3
Choose a simple line chart type

Now the Total data is noticeably different from the Point data

Step 1
Select the Total data series in the chart

Click % Format Selection

Step 2

On the Series Options category, choose to Plot series on a
Secondary Axis

Step 3
While you are here, have a look at what some of the other tabs
allow you to do, but do not change anything.

When you have finished exploring, choose

Step 4

Notice that the axis for the Total data is marked on the right-
hand side of the chart, and the values are quite different from
those on the primary axis

The maximum and minimum values have been set
automatically (we will fix this shortly)

Step 1

Select the Secondary Value Axis on the right-hand side of the
chart — if it is too difficult to click the axis, use the Chart
Elements drop-down list at the left end of the Chart Layout
or Chart Format tab of the ribbon

Step 2

Click %y Format selection on the Chart Layout tab of the
Ribbon
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Step 3

In the Axis Options tab, set a fixed Minimum of 0 and a
fixed Maximum of 500

Task 7 Step 1

Add a title for the secondary Vertical Axis g
On the Chart Layout tab of the ribbon, click .=

Titles -

Step 2

Choose Secondary Vertical Axis Title, and Rotated
Title

Step 3
Click in the Axis Title box, and type Total Scores

Task 8
Format and label other elements of the chart, to make it clear and easy to understand

Close the workbook, saving if you wish

Exercise 20 Create a line chart

. Create a Line chart showing the courses that a group of students attended in 2003 and 2004 -
See Section 9.1

Task 1
Open class attendance .xIsx at the Classes 2003-4 worksheet

This shows the numbers of times certain courses were run

Task 2 Step 1

Create a line chart showing the number of | Select cells A3:C30
times courses were run over the years

2003 and 2004 Step 2

Create a line chart with markers

Step 3
Work on the chart so it looks similar to Figure 4 below

Task 3
The chart shows two data series, for years 2003 and 2004

The categories (course titles) are listed on the horizontal axis
The values (numbers of students attending) are plotted against the vertical axis

Task 4
Move the chart to a separate chart sheet, calling it Attendance_Line

Task 5
Leave the class attendance workbook open, for a later exercise
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A |

10 &

Frequency of Courses
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Number of courses per year

~——Year 2004
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Figure 4 Frequency of courses

Exercise 21 Create a basic scatter chart

. Create a scatter chart based on pairs of numbers - See Section 9.2
o Choose data point markers - See Section 9.2
o Improve the labelling and formatting - See Section 9.2

Task 1

This task is to create a scatter chart to show the relationship between current and voltage measured
in an electrical circuit

Open Ohms Law experiment.xIsx

Task 2 Step 1
Create an XY scatter chart of the Select cell D3:Eg on the Ohm’s Law worksheet
experimental data
Step 2
Create an XY (Scatter) chart
Step 3
Use the Chart sub-type Scatter with Straight lines and
Markers
Task 3 Step 1
Improve the labelling and formatting [

Add Chart

Use Add Chart Element ===t~ to add titles for the axes:
voltage / V (horizontal)

current / A (vertical)
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Step 2
Remove the legend which is not needed

Step 3
Change the range over which each axis is plotted, if you wish

Step 4
Format the vertical axis to show figures to 1 decimal place

Task 4
The completed chart should look similar to this:

Ohm's law experiment
N /

0.0

2.5

2.0

=
w

current f A

-
o

o] 5 10 15 20 25 30
voltage / V

Figure 5

Task 5

Use the chart to think about the data: if one of the points seems out of line with the rest, perhaps it is
an outlier?

You might go back to the experiment to investigate the details of that measurement, whether it was
done in a different way or needs a repeat test

Task 6
Close the workbook, saving changes if you wish
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Exercise 22 Create another scatter chart

° Create a scatter chart - See Section 9.2

o Use the same data from the earlier (Line Chart) exercise - See Section 9.2
. This time, plot the data in pairs on two numerical axes - See Section 9.2
Task 1

Continue work in class attendance .xIsx or open class attendance partial1.xIsx at the Classes
2003-4 worksheet

Inspect the data: for each course title named in column A, columns B and C show the number of
times the course ran in 2003 and 2004

Task 2 Step 1

Create an XY Scatter chart using the Year Select cells B4:C30

2003 and year 2004 courses data Step 2

Your .chart should have two value axes, ) Create an XY Scatter chart using the chart sub-type
showing Year 2003 data along the X-axis Scatter With Only Markers

and Year 2004 along the Y-axis
Step 3

Note that a scatter chart has two value axes: one set of

numerical data is plotted along the X-axis and another set of

numerical data is plotted along the Y-axis

Step 4

Hover the mouse pointer over a data point and identify which

data row in the worksheet (columns B and C) it represents
Task 3 Step 1

Annotate and format the chart to match Add the necessary titles for X-axis, Y-axis and the chart

the example below Step 2

Delete the legend

Step 3
Format both axes to have a fixed scale from o to 10

Step 4
Set the major unit of the vertical axis to 2

Step 5
Give the chart a title
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Number of Courses - Comparison by Year

Coursesin 2004
*
*

Task 4

4 5 6 7 8 9 10
Coursesin 2003

Figure 6

Save the chart as a new sheet, and name it Attendance_Scatter

Exercise 23 Improve the scatter chart with a line (Optional)

. Add a diagonal line to help understand the data meaning - See Section 9.2

Task 1

Continue work in class attendance .xIsx or open class attendance partial1.xIsx at the Classes

2003-4 worksheet

Continue work to improve the Attendance_Scatter chart

Data values are provided in columns E and F, for the bottom left and top right corner of the chart

Task 2
Add a diagonal line from (0,0) to (10,10)

Hint: use Paste Special to paste the data
onto the chart as an additional data series

IT Learning Programme

Step 1
On the sheet Classes 2003-4, select the range E4:F5

Copy

Step 2
Don’t simply paste!

Click once on the Plot Area of the scatter chart

Click the down arrow on the Paste button (onthe Home
tab)

Choose Paste Special from the menu

Step 3
Complete the Paste Special dialog box as shown below

Red markers appear on the chart at (0,0) and (10,10)
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Add cells as alues (Y)in—;
™ New point(s) i” Rows
¥ Mew series = Columns

[ Series Mames in First F.ow
I iCategories (¥ Values) in First Columni
[~ Replace existing categories

Ok I Cancel

Figure 77
Task 3 Step 1
Change the chart sub-type for the new Carefully select the new data series
data series to be a line
Step 2
il

Select  change

Chart Type

Step 3
Change the Chart sub-type to Scatter with Straight lines

10 *

Number of Courses - Comparison by Year
- .
8 + +
- . .

[ * + *
3
g
=
H . - -
¢
£
S

4 .

* *
2 +
.
0 . : : . : . : : :
0 1 2 3 4 5 6 7 8 9 10
Coursesin 2003
.
Figure 8
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Task 4
Look at the chart you have made

Most of the points lie on or above the y=x line — what does that tell you about course numbers in
2004 compared with 2003?

[In the second year, most of the courses were run the same number of times or more often, compared
with the earlier year]

Task 5
Close the workbook, saving if you wish
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e Create a histogram showing IQ distribution - See Section 10.3

e Create histograms to show all four types of distribution - See Section 10.3

Task 1

In this task you will create a histogram
from 1000 records showing people’s 1Q
test results

Step 1
Open the 1Q worksheet in Histograms.xlsx

Cells A7 to A13 show the boundaries of the |Q ranges (called
bin ranges).

E8 to E1008 contain the 1Q results, which in the Histogram
isthe Input Range.

Select the Data tab on the Ribbon and select Analysis

FH . .
gfq Data Analysis

Then select Histogram, from the Data Analysis dialog box.

Click

Descriptive Statistics
Exponential Smoothing

Data Analysis e X
Analysis Tools
Anova: Two-Factor Without Replication o
Correlation -m
Covariance

Maving Average

| |F-Test Two-Sample for Variances
Fourier Analysis

Random Mumber Generation

m

Help

Step 2
Complete the fields in the Histogram window.

For Input Range: enter the location of the results:
SES$8:$E$1008.

For the Bin Range: enter $A$7:$A$13.
Tick the Labels box.

For the Output Range click into cell: $G$7
Tick Chart Output

Click
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Histogram m
Dg .

Input
— 0K

Input Range: $ES8:4E61007 Lok |
— Cancel

Bin Range: SASTISAS13

Hel

o=

QOutput options

@ Qutput Range: 5557 3

(71 Mew Worksheet Ply:

(™) Mew Workbook

[ Pareto {zorted histogram)

[7] cumulative Percentage

Chart Output

A table showing the frequency distribution of the input range
and the histogram will be added to the worksheet see below

You now need to format the chart.

Q Freguency .

69 2 Histogram

79 67 600

89 159 &

109 505 g 40

119 157 g z00

w B Frequency
129 64 o
More o 69 79 89 109 119 129 More
1a
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Step 3

Format the histogram.
Firstly increase the width of the columns in the chart.

Right-click the data series then select Format Data
Series...

In the Format Data Series dialogbox and in Series
Options section set the Gap Width to 0%.

Click

Format Data Series ¥ %

SERIES OPTIONS «
SO M

4 SERIES OPTIONS

Plot Series On
Series Overlap —+ | 0% z
Gap Width I 0% :

The completed histogram should look the same as below.

You can see quite clearly 505 people falling into the 90-109
range with a symmetric distribution of data.

Save your work and keep the file open.

Q Frequency

69 22

79 67

89 159

109 505

119 157

129 64

Maore 25

600

Frequency
g 8§ §

3

100 +

Histogram

B Frequency

&89 79 89 109 119 129 More

Task 2
This task is to create additional

histograms showing the common ways
histograms can be defined with differing

distribution of data.

Step 1

Create histograms in the same way as Task 1 using data from
the following worksheets:

Family Income
The histogram should look like below

95 IT Learning Programme




TMSE3 Organising and Displaying Data

Family Income Frequency

o Histogram
14999 317 350
19999 218 300
24399 178 g0
g 200
29999 115 s
34999 7 £ 100
3 b = W Frequency
44599 EES o
B R R R N B
More 49999 zi & '\?“ﬁ '3@ m‘@ w‘*@ '5”‘# '5"@ u"* v‘”@ +©
Family Income
Step 2
Days from conceptlon
The histogram should look like below
Pregnancy days Frequency
239 E Histogram
245 13
249 34
255 87 e
259 177 g 250
265 278 e
269 330 £ 100
275 54 53 W Frequency
More 12 ‘{,’9 W‘;o x@ {;-, m@ ‘\9'7 ’_L,OQ 1\@ @9‘5

Pregnancy days

Step 3
Pulse Rates

The histogram should look like below

Pulse RateFrequency

49
55
59

65
(3]
75
79
a5
89

More

7
20
56

Histogram

Pulse Rate

= Frequency

More

Save and close your file
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Exercise 25 Create Office 2013 Sparklines

e Use Sparklines to spot trends in Crystal Ball shares data - See Section 11.1

e Customise the Sparkline - See Section 11.1
e Explore the effect of hiding part of the data, on a Sparkline - See Section 11.1

Task 1

Create Sparkline charts to show how
Crystal Ball investment trusts have
performed since 2006

Step 1
Open Crystal Ball Shares.xlsx
The data you will be using is in the Shares worksheet

This workbook contains data showing the performance (share
price) fluctuations for four investment trusts over a six year
period

Step 2
Select cells T4:T7, the cells where the Sparklines will appear
Select Insert | Sparklines and choose the Line button.

ﬂ [}

Line % &'umn Win/Loss

IN
I:

Sparklines

Step 3
In the Create Sparklines dialog, complete the boxes:

Data Range are the cells whose values you want to appear in
the chart

Location Range is the cell where you want the chart to
appear in the worksheet

Click on
Create Sparklines - l P |-

Choose the data that you want

L]
1

Data Range: |B4S7T ERz
Choose where you want the sparklines to be placed
Location Range: | STS4:5TS7 E

QK ] | Cancel |
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Task 2
The Sparkline Tools tab will now appear automatically on the Ribbon when a Sparkline is selected.
FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER Muance PDF DESIGM
i irst Poi | LZ sparkline
S AA | il Mt High Paint First Point Fsp
1-’7 j: ]I :11 Low Paint Last Point \/\/\ \/\/\ \/\/\ \/\/\ \/\/\ \/\/\ ~| [ Marker Cof
Edit Line Column  Win/ -
Data ~ Loss Negative Points Markers =
Sparkline Type Show Style
T4 - e
K L M N 0] P Q R S T
1
2
3 |15-]an-09 16-May-09 30-Dec-09 22-Mar-10 31-Aug-10 13-Dec-10 04-Apr-11 13-Aug-11 14-Sep-11
4 £3.010 £3.230 £3.660 £3.810 £3.615 £4.060 £4.172 £3.840 £3.632|7 "~
5 £2.040 £2.100 £2.440 £2.600 £2.544 £2.830 £2.930 £2.730 £2.621)° M~
6 £2.170 £2.400 £2.730 £2.890 £2.680 £3.010 £3.165 £2.850 £2.778|—
7 £4.470 £4.540 £5.280 £5.550 £5.680 £6.220 £6.360 £6.120 £5.895|7 v _—
8
Task 3 Step 1

Customise the Sparklines to highlight the
highest and lowest values

Select one of the Sparklines you created

Step 2
From the Sparkline Tools tab check High Point and Low
Point in the Show group

This will highlight the highest and lowest points of data in the
Sparkline group

Step 3

Select one of the many different design styles, see below

Show

High Point First Point -
Low Point Last Point "Vf\/\ \/\/\ \/\/\ \/\/\ \/\/\ \/\/\ -
Megative Points Markers -

Style

Task 4
Change the Sparkline to a column type

IT Learning Programme

Step 1
Select another of the Sparklines you have created

Step 2

Click on Column in the Type group, to change the selected
Sparkline to a column Sparkline. Widen the column to provide
a better view of the Sparkline.
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FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER Muance PDF DESIGN
i i irst Poi .| LZ sparkline ¢
e A il TN High Paint First Point e Sp
]—.; ]: ]I ]1 Low Point Last Paint I|||III_I||III I'II||I-|I'I|I |||III._I||II| |||IIII_I||III I'II||I-|I'I|I |||III._I||II| - B Marker Co
Edit Line Column Win/ -
Data~ Lass Megative Points Markers -
Sparkline Type Show Style
T4 -
K L T
1
2
3 |15-Jan-09 16-May-09 30-Dec-09 22-Mar-10 31-Aug-10 13-Dec-10 04-Apr-11 13-Aug-11 14-Sep-11
4 £3.010 £3.230 £3.660 £3.810 £3.615 £4.060 £4.172 £3.840 £3.632 | ik _alin
5 £2.040 £2.100 £2.440 £2.600 £2.544 £2.830 £2.930 £2.730 £2.621| MM ol
6 £2.170 £2.400 £2.730 £2.890 £2.680 £3.010 £3.165 £2.850 £2.778| bl i
7 £4.470 £4.540 £5.280 £5.550 £5.680 £6.220 £6.360 £6.120 £5.895 |l _am
2
Task 5 Step 1

Sometimes, you will want to hide part of
the data from a Sparkline

Try the effect of hiding columns, on a

Sparkline

Select columns J to P in the worksheet

Step 2

Select Home | Cells | Format | Hide & Unhide | Hide
Columns (or use the right-click menu)

Step 3

Columns J to P in the worksheet are now hidden and the data
there does not show in the Sparklines

Step 4
Select the Sparkline cells
From the Sparkline Tools Design tab and in the

Sparkline group, select Edit Data | Hidden & Empty
Cells

QUCS shares.xlsx

Insert Page Layout Formulas Data Review

vl el B High Paint [ First Point
}:Z "n u
Low Paint [ Last Point |'||||.
Line |Caolumn|Win/Loss
|:| Megative Points ars
dit Group Location & Data... Show
£ |
Hidden & Empty Cells... ‘g H I
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Step 5

Check Show data in hidden rows and columns,

Click

Hidden and Empty Cell Settings X

Show empty cells as: @ Gaps

Show data in hidden rows and columns

(71 Zero

Connect data points with line

Ok ] [ Cancel

The completed Sparklines should look the same as below.

N O P Q R S T
1
2
3 | 22-Mar-10 31-Aug-10 13-Dec-10 04-Apr-11 13-Aug-11 14-Sep-11
4 £3.810 £3.615 £4.060 £4.172 £3.840 £3.632 wuiiilnl___suullns
5 £2.600 £2.544 £2.830 £2.930 £2.730 £2.621 gillNlnl___ouxllnn
6 £2.890 £2.680 £3.010 £3.165 £2.850 £2.778 aunnullal___sisillns
7 £5.550 £5.680 £6.220 £6.360 £6.120 £5.895 slINRluNE___.sumEnEm
Save your work and close the file
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13 What Next?

In all cases, please refer to the IT Learning Programme web page (via
www.it.ox.ac.uk/courses/) for further details.

13.1. Courses Which Precede This

Office Fundamentals

Spreadsheets: Techniques for managing and checking data

13.2. Other Courses in Spreadsheets and Statistical Analysis

Spreadsheets: Techniques for managing and checking data
Spreadsheets: Advanced data analysis

Spreadsheets: Summarising data using pivot tables
Spreadsheets: An introduction to working with statistics

... and various courses on using NVivo, R, SPSS and Stata.

13.3. Courses in Programming Languages

For those who need to process large amounts of data, knowledge of a
programming language such as C, C++ or VB may be useful.

These are easily accessed with a simple program. An range of courses are
available, so see the IT Learning Programme catalogue for further details:
www.it.ox.ac.uk/courses/ .

13.4. Other analysis software

MATLAB is a high-performance language for technical computing. The
introductory course provides a working introduction to the MATLAB technical
computing environment. Themes of data analysis, visualization, and
programming are explored throughout the course

SPSS is a package which combines a wide range of tabulation, statistical analyses
and graphical displays with the necessary data and file management facilities to
exploit them. SPSS is a general-purpose statistical package widely used within the
academic community.

Stata is a powerful quantitative software package that provides everything you
need for data management and manipulation as well as descriptive, statistical,
graphical and survey analysis of quantitative data. A series of courses are
available.
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14 More Help

14.1. Course Clinics

We encourage everyone to work at their own pace. This may mean that you don’t
manage to finish all of the exercises for this session. If this is the case, and you
would like to complete the exercises while someone is on hand to help you, come
along to one of the Course Clinics that run during term time.

More details are available from www.it.ox.ac.uk/courses/

14.2. Downloadable Course Materials and More —
the ITLP Portfolio

These course materials are available through the ITLP Portfolio, at
http://portfolio.it.ox.ac.uk .

Each course pack includes the course handbook in pdf form and a zip folder of the
exercise files that you need to complete the exercises. Archive versions of the
course book may also be useful if you use an earlier version of the software.

The ITLP Portfolio helps you find articles, videos, resources and weblinks for
further IT study. For some resources, you will be asked for your Oxford (SSO)
username and password.

14.3. Further Help

It may be possible for you to use ITLP facilities in IT Services, Banbury Road to
work through the exercises in this booklet after the course, or when you don’t
have access to the applications on your own computer. Contact us on
courses@it.ox.ac.uk for details.

The IT Services Help Centre is a good place to get advice about any aspect of
using computer software or hardware. For Help Centre opening times, visit
www.it.ox.ac.uk/help/gettinghelp/ and follow links to the General Helpdesk, or
contact them by email on help@it.ox.ac.uk.

IT Learning Programme 102


http://www.it.ox.ac.uk/courses/
http://portfolio.it.ox.ac.uk/
mailto:courses@it.ox.ac.uk
http://www.it.ox.ac.uk/help/gettinghelp/
mailto:help@it.ox.ac.uk




Spreadsheets: Organising and
Displaying Data

Traci Huggins

IT Learning Programme

03/09/2015

Today’s arrangements .....

Your teacher is: Traci Huggins
Your demonstrator is:

We finish at:

This is a hands-on session so get stuck in and have
fun - don’t be afraid to experiment!

Your safety is important .....

Your comfort is important ....

Where is the fire exit?

Beware of hazards

Please tell us if anything does not work
Let us know if you have any other concerns

The toilets are along the corridor just outside the
teaching rooms

The rest area is where you registered;
it has vending machines and a water cooler

The seats at the computers are adjustable

You can adjust the monitors for height,
tilt and brightness

What you will learn today ......

Add-Ins .......

Working with ranges and tables of data
Filtering your data
Subtotal and grouping your data

vV V V VYV

Working with and creating different chart
types
Formatting charts

Y VY

Creating Histogram’s and Sparkline's

During this session you will be using functions and
features that are not available by default.

These functions and features need to be added into
Excel - to activate the Add-Ins;

File | Options | Add-Ins |

Then select the Add-Ins available - Instructions on
Page 44 (12.4 Analysis ToolPak) ...
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Excel 2010: A Quick Tour/Refresher .....

Refresher: Quotation marks in formula

The Ribbon/Toolbar: where the menus are

\

The File Tab: called ‘Backstage view’ - where you go for
printing and creating new files

The Grid/Data Sheet: where
your data goes, in columns

IMPORTANT:  Any text criteria of any criteria that includes logical
or mathematical symbols must be enclosed in double quotation
marks (“). If the criteria is numeric double quotation marks are not

required.
Examples:

=SUMIF(A2:A5,">160000",B2:B5) - Quotation marks are needed here
because we have the more than sign included in the formula.

=SUMIF(A1:A7,"Fruits”,C1:C7) - Again quotation marks are needed
as we are using text in the formula.

and rows =SUMIF(A2:A5,300000,B2:B5) - Quotation marks not needed here as
the criteria is a numerical only.
Ranges and Tables in Excel ...... Creating tables in Excel ......
Ranges - consists of a group of A
cells group together i.e. A1, By converting your range of
AZ,A3, B1 ,BZ, B3, C1 ,C2, c3 data to a table you will
ensure when further data is
added to the table it will
be included in the data set
Tables — however is a new way of working with
tabular data, tables have additional functionality and
are more helpful in appearance than ranges ;
Once your table is created the ribbon will BN Hhsance
automatically update and give you a tab ) Flar Bstin

called Table Tools this will then give you
options to format your table accordingly

Filtering Data ...... .

Summarize your Data ......

There are lots of ways in which you can use to
Filter your data including;

e Auto filter e Extract unique records

Filter by selection « Apply an advanced filter
» Top 10 auto filters « Filters using AND/OR

« Filter by colour * Clear Filters

Subtotals - is a feature used in Excel to enable
you to summarise data in a range.

» Subtotal a range
> Remove Subtotals
» Hide and show details
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Exercise; Working with Tables in Excel

Chapters 1-4
Your files are on H:\
Start at page 52; work through Exercises 1 - 9

Please ask for help if needed!

START AGAIN AT:- about

Charts ...... . Creating a chart .....

» Creating an embedded chart

» Creating charts Select a series of data

. . Insert tab - choose from Charts
» Chart options and formatting

> Data series on a chart > Creating a chart on its own sheet
» Charts with lines Select the range of cells, then press <F11>
Immediately creates a default chart on a new chart
sheet
Creating a Chart ... Chart Toolbar ...
Design Tab

Firstly select the range
of data that you need
to create the chart

Select the quick
analysis from the icon
to the left of the data
just selected, choose
chart, you will then
see the following
options available to
choose your chart.

Format Tab
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Labelling/Formatting parts of a chart ...

Selecting parts of a chart ....

Chart Title Legend

Plot Area Vertical (Value) Axis

7 Major Gridlines

\ Horizontal (Category) Axis

T

Vertical (Value) Axis

Vertical (Value) Axis Title

Select objects on a chart

Click a chart object once to select it
Blue handles show which part is selected

Select a data series or a data point

Click once to select a data series,
again to select a data point

Formatting parts of a chart ....

Controlling the axis scale ....

Move or resize chart objects using handles
Format using toolbar buttons

Or select then % rormat selection | ot Data series v x

SERIES OPTIONS ¥
SO M

b OFLL

b BORDER

Select the required axis

Set a Minimum or Maximum value as needed

1mm 08

1m0 a0

mm o
@m o
@m o
mm s
am o0
- ab [ e s [ war sor

Labelling parts of a chart ....

Plotting non-adjacent areas ......

Labels can help understanding

f?

Not all data for charts use adjacent cells.

If you need to create a chart that uses cells from other areas
in your data sheet you need to ensure that you select the
first set of cells In order to create chart then select CTLR
then select the next range of cells
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Adding a data series ....

A chart with mixed types ....

Inserting another data series on an existing chart
Copy and Paste the additional data

or
Chart Tools | Design | Select Data

Click

and select the data range to add

Make one data series stand out, use a different
chart type

A chart with a secondary axis ....

XY-scatter charts ....

One series has a different range

England JanMarch
100 =500
100,00 2000
2000 HEO [ o
E 24000
j o r——
= 2w (== Fat
awm e p—
200 500
oo o

Ponti  Pant2  Fom3  Ponid

Better to show the line chart against a different
value axis scale

Line chart

Category information evenly spaced
along the x-axis

Static Frequency

IR

X-Y Scatter chart

Has two numerical axes

Shows one set of data along the x-axis
and another set along the y-axis

Trend lines on a scatter chart .... Sparkline’s ......... . Ba___
A B C D E F G H
) 1 Exam Results
Trend line , T 1 <1 2+
R-S Uared 3 Writing 8 5 3 3 2 .-__,
q 4 Reading 10 3 5 2 1 .—-_,
5 Listening 5 8 20 2 2 —-.__
6 Speaking 7 8 5 1 0 .l._

7

Sparkline's can be easily added with just a few clicks of
the mouse. They are dynamic and update automatically
when the source data changes




03/09/2015

Histograms ............. _.rﬂ_ht

Other Excel Courses .....

A Histogram is a chart that shows a visual impression of the distribution of
data across categories and is commonly used to summarise a long list of
data

Excel: Techniques for managing and checking data.
Excel: Creating professional data views.

Excel: An introduction to working with statistics
Excel: Advanced data analysis

Excel: Summarising data using pivot tables

Excel: Arrays, Macros and VBA

http://portfolio.it.ox.ac.uk/

Other Courses .....

¢ Course Clinic
« IT Help Centre

¢ Intro to statistics

This presentation is made available under a Creative Commons
licence: Attribution, Non-Commercial, Share Alike.
Individual images are subject to their own licensing
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Exercises - Creating and Formatting
Charts...

Exercises: 10 - 25

FILES are on H:\ Course Files for Excel 2010

Please ask for help if needed!




	TMSE3 - Spreadsheets Organising and Displaying Data
	BLANK PAGE
	TMSE3 - Organising and Displaying Data PP

